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INTRODUCTION

This user guide acts as a reference for end users on how they can use the features for

Succession Planning. In this user guide, it will show the users on how they can:

Create and Assign Job to Position.
Maintain Qualification Catalog.
Assign Qualification to Job.

Assign Quialification to Position.

1.

2

3

4

5.  Assign Qualification to Person.
6 Assign Quialification to Person.

7 Mass Assign Qualification to Person.
8 Mass Upload Qualification Catalog.

9 Mass Assign Qualification to Job.

10. Mass Assign Qualification to Position.
11. Mass Assign Qualification to Person.

12. Succession Planning Reporting.

Should you have any questions or require additional assistance with the user

guide materials, please contact the SSM Help Desk.

FURTHER ASSISTANCE

Should you have any questions or require additional assistance with the user guide materials,
please  contact SSM Help Desk at +673 238 2227 or e-mail

at ssm.helpdesk@dynamiktechnologies.com.bn.
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Process Overview

Add Transaction Codeto Favourites

start Log on Right click on Click an Enter Click on End
SAP GUI Favorites Insert Transaction PPO1 Tick icon
Maintain Job (JPA)
Enter Select . .
( stant }—. Aceess | L MzinzinObject |—»|  oObjecy [ Cicken L Crese | p Clickon 4.{ end |
PROL1 Create icon Ohject Save button
fields Infotyps
Assign Job to Position (JPA)
Enter Select _ '
Start Access = Maintzin Object  —»{ Relationships — Click ',:'n CI—_E“E B Click on End
FFRO1 Create icon Relationships Save button
fields Infotyps
Maintain Qualification Group (JPA & SPA)
Create
Acoess Click on Select Click on . . Click on Click on
[ start [alelully Creste icon Qualification Group Creste icon Quzlrzila:on Save button Tick icon End ]
Maintain Qualification (JPA & SPA)
o Acress Click on Select Click on Qu:;;:::ion Click on Click an e
000A Create icon Qualification Create icon Group Save button Tick icon
Mass Assign Qualification to Person (JPA)
start Acoess Salect Find Create Enter Click on end
Ooam Person Personnel Qualification Proficiency Save button
Mass Upload Qualification Group (JPA)
Click on
Access Salect . Add selected Click on
| start ZHCMSPOOL_MASS Qualification Group Uplozd File E:j;::_le Qualification Group Export button End ‘
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Process Overview

Mass Upload Qualification (JPA)

I T B el o v o s o - I
Mass Assign Qualification to Job (JPA)
| Start }—p ZHCM:I‘:DDE;_MASS ] If::;:l - Upload File  |—m %EE% — Sisaiir;ei::li:\:t: e Expil::izztﬂn —.| End ‘
Mass Assign Qualification to Position (JPA)
| start }_' ZHCM:;DD;E_MA&S ™ Pieslite'::n > UplosdFile i — ;Eu:% - STJE;E:Z:;E?: ™ apgﬁiﬁlm 4’{ End |
Mass Assign Qualification to Person (JPA)
| Start }—p ZHCM:;DDI:;_M.&SS ——] :::::I L Upload File  |—m %EE;E; — Siiir;ei%%:: —— Expcc:ﬁl::‘:zuz:tﬂn —.| End ‘

Assign Qualification to Person (Dept HR Development)

=5

Access
PA30

Enter
Personnel no.

Create
Qualification

Click on
Change icon

Click on Create

Select
Qualifications

Click on
Save button

View Qualification Catalog (Dept HR Development)

-

Access
PPQD

H=)

Generate Profile Matchup Report (JPA, SPA & Dept HR Development)

Access Select Select Click an
Start — e . Execute End
PEPM Person Position
button
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Process Overview

Generate Career Planning Report (JPA, SPA & Dept HR Development)

Access
[ Start ]—‘ PPCP ——

Select
Person/lob

L

Click on
Execute
button

Include end
Qualifications

Generate Succession Planning Report (JPA, SPA & Dept HR Development)

Access
(= H =

Select
Paosition/Job

Click on
Execute
button

Include £nd
Qualifications

Generate Succession Overview for an Organizational Unit Report (JPA, SPA &
Dept HR Development)

Start Access
S_PH9_46000017

—

Select
Organizational

—

Unit

Click on
Execute

button

Include
Qualifications

)
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Backend User

MAINTAIN JOB

Log into SAP GUI (Back End) and proceed with the following steps.

1. Enter transaction code PPO1 in the search bar.

SAP Easy Access

SAF
IPPOl ﬁ H = L &S Ohermenu ¥ & S V A ™ Createrole More v

> [ Favorites
994 Mend
> [ Connector for Multi-Bank Connectivity
» [ Office
> [ Cross-Application Components
> [ Logistics
> [[3 Accounting
» [ Human Resources
> [ Information Systems
> [ Service
> [ Tools
> [J WebClient Ul Framework

Note: Maintain Object Page will be displayed.

< ».3- P4 Maintain object

& 0 /7 & @A O W B » Moev

Exit

Find by
* Plan version: |[Current plan
* Object type: Unknown
Object ID

Object abbr.

Active Planned Submitted Approved Rejected

Infotype Name 5. o Time period
C @ Pericd
* From: | 17.05.2022 t0:/31.12.999%
Today Current week
All Current month
From curr.date Last week
To current date Last month
Current Year
] Select

SSM_UG_SP_Back End (SAP GUI)_JPA_v1.0
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2. Enter ‘Job’ for Object Type.
3. Select ‘Object’ under Infotype.
4. Click on the Create icon.
: < y Maintain object :

4 ;‘ & A [ W @ »» Mo

Y A

Find by

ek . * Plan version: Current plan
* Object type] Job

Object ID
Object abbr.
Submitted

Active Planned

Approved

Rejected

Time period

i Infotype Name ®
® Object : @ Period

Relationships

Description

Planned Compensation
Cost Planning

Standard Profiles

PD Profiles

Job Evaluation Results
Survey Results
Qualification Management
CIC Profile

* From: | 23,05.2022 10: 31,12.9999

Today Current week

Al Current month

Last month

Current Year

IC: Weh Client Profil v

Note: Create Object Page will be displayed.

= < B —F x
< K : J Create Object
~ G G Morew Exit
¥ A
Job:
Find by Planning Status: Active
St * Validity: | 23.05.2022 | *t0: 31.12.9999

Object
* Object abbr
Object name:

Language Key: English

SSM_UG_SP_Back End (SAP GUI)_JPA_v1.0
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5. Change the Validity date.
Note: The Job Validity Date should be setto a date older than the assigned position.
6. Fill Object Abbreviation field.
7. Fill Object Name field.
8. Click on the Save button.
= C B -8 %
|~ < W Create Object
G (G Morew Exit
Find by Planning S Joi acive [}
tot: : --«m‘un;‘ ‘o 31,12,9999
Object I:‘
Language Key: English
8
Save ncel

Outcome: A new Job Object has been saved.

* Plan version: |[current plan

* Object type: Job
Object ID: 20000125

Object abbr.: SSA0101

Submitted

Active Planned

Infotype Name

® Object
Relationships
Description
Planned Compensation
Cost Planning
Standard Profiles
PD Profiles
Job Evaluation Results
Survey Resulls
Qualification Management
CIC Profile
I Weh Cliant Profil

More ~

SuperScale A

Approved

S..
v

Maintain object

Rejected

@ Time period
z @ Period

* From: 23.05.2022

Today

AlL

From currdate

To current date
=] Select

Exit

t0: 31.12.9999
Current week

Current month

Last month

Current Year

Record created

SSM_UG_SP_Back End (SAP GUI)_JPA_v1.0
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ASSIGN JOB TO Backend User

POSITION

Log into SAP GUI (Back End) and proceed with the following steps.

1. Enter transaction code PPO1 in the search bar.

g

IPPOl & & & Othermenu

> [ Favorites
994 Mend
> [ Connector for Multi-Bank Connectivity
» [ Office
> [ Cross-Application Components
> [ Logistics
> [[3 Accounting
» [ Human Resources
> [ Information Systems
> [ Service
> [ Tools
> [J WebClient Ul Framework

Note: Maintain Object Page will be displayed.
: < y Maintain object

& 0 /7 & @A O W B » Moev

Find by
* Plan version: |[Current plan
* Object type: Unknown
Object ID

Object abbr.

Active Planned Submitted Approved Rejected

% v A

Infotype Name 5. o Time period
C @ Pericd
* From: | 17.05.2022 t0:/31.12.999%
Today Current week
All Current month
From curr.date Last week
To current date Last month
Current Year
] Select

SAP Easy Access

™ Create role More v

Exit

SSM_UG_SP_Back End (SAP GUI)_JPA_v1.0
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2. Enter ‘Job’ for Object Type.

3. Select ‘Relationships’ under Infotype.

4. Click on the Create icon.

= G 5 X

B < W 4 Maintain object

& Z 6 A 0 W @ # Moev Exit

Object ID: 20000125 SuperScale A

Object abbr.: SSA0101
Active Planned Submitted Approved Rejected

Infotype Name @ Time period
Object g ® Period
pelatinehis * From: 23.05.2022 t0: 31.12.9999

Description
Planned Compensation

Today Current week

Cost Planning Al Current month

Standard Profiles Fron
PD Profiles

Job Evaluation Results
Survey Results

Last

Last montt

Current Year

Qualification Management
CIC Profile ~] Select.

IC. Weh Client Profil

Note: Create Relationships Page will be displayed.

= | < ,.3 ! D 4 Create Relationships

~ [ 7 Alowed relationships  More v

Exit

> Y A
~ = Job: 55A0101 Superscale A
Find by Planning Status: Active
~ E] Job * Valid from: | 24.05.2022 * to: 31.12.9999 63 Change Information

@, Search Term

Relationships

Relationship type/relationship:

Related Object

Type of related object: v

Priority:

Weighting:

SSM_UG_SP_Back End (SAP GUI)_JPA_v1.0 12
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5. Change the Valid from: date.
Note: The Valid from date should be setto a date after the Job’s Validity date.
6. Choose the Relationship Type: ‘A | 007°.
7. Choose the Type of Related Object: ‘Position’.
8. Choose a position for ID of related object
9. Fill the Weighting: 100%.
10. Click on the Save button.
= < 6 _ 8 %
nihd < w Create Relationships
~ [E G Allowed relationships  More v~ Exit

Job: SSA0101 SuperScale A

Find by Planning Status: Active 5

~ [ Job * Valid from§| 24.05.2022 |/ f to: 31.12.9999

4 Search Term
Relationships 6
Relationship type/relationship) Describes
Related Object
Type of related object] Position ~ q

1D of related object] 30081244

&3 Change Information

Abbreviation: SAQL

Name: PENYELIA PEJABAT

Priorty: 9

Outcome: A new Relationship has been saved.

= < B -9 x
v < ..2! " Maintain object
& 1 £ & 6 [0 W & »# Morev Exit
*” ¥ A
Find by
= T 5
~ B Job * Plan version: |[Current plan -
4, Search Term 1
A searh Ter * Object type: | Job N
Object ID: | 20000125 SuperScale A
Object abbr: $SA0101
Active Planned Submitted Approved Rejected
Infotype Name S.. @ Time period
Object v l @ Period
C) LI v * From: | 24.05.2022 o 31.12.9999
Description
: Today Current week
Planned Compensation
Cost Planning All Current month
Standard Profiles From curr.date eek
RE e To current date Last month
Job Evaluation Results
Current Year
Survey Resulls
Qualification Management
CIC Profile =] Select

I Weh Clienr Profil

Record created

SSM_UG_SP_Back End (SAP GUI)_JPA_v1.0
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MAINTAIN Backend User
QUALIFICATION

GROUP

Log into SAP GUI (Back End) and proceed with the following steps.

1. Enter transaction code OOQA in the search bar.

SAP Easy Access

IOOQA TI H @ L S Ohermenu ¥ H* 2 v A = Createrole  More v

[Eraered

~ 13 SAP Menu
> [ Connector for Multi-Bank Connectivity
> [ Office
> [ Cross-Application Components
> [ Logistics
> [[3J Accounting

» [ Human Resources

> [ Information Systems

> [ Service

> [O Tools

> [J WebClient Ul Framework

Note: Catalog: Change Qualification(s) will be displayed.

< B B %
- < W Catalog: Change Qualification(s)
a 0 AV ¥ A = Posiion = Segment @  More ™ Q  FindNext & Exit
lcatalog T 01.01.1900 - 31.12.9999 01 current plan

1 [0 Government Of Brunei Darussalam

SSM_UG_SP_Back End (SAP GUI)_JPA_v1.0 14
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Note: User may navigate to More > View > Key on: Additional data on to show the Object

ID of the catalog items and its scale.

R

vi@a (] W =™ A Vv B ¥ A = Posion

Q  Find

Cancel (F12)

catalog 01.01.1900 - 31.12.9999 01 Current plan Entry >

Edit >

LEI [J Government Of Brunei Darussalam Goto
I View > Key on (Ctrl+F7)

o [ General
@ [J Ministry Specific Qualification

Settings >

] Pejabat Suruhanjaya Perkhidmatan Awam System > Additional data on  (Ctri+F6)
g [ skim Perkhidmatan Requirement Help > Switch Layout
o [J UAT Testing Data . .
SAP GUI settings and actions > Color Legend (Shift+Fa)

Note: The Object ID of the catalog items and its scale system will be displayed.

= v < ALK Catalog: Change Qualification(s)
v Qe [ W @ A v B ¥ A = Position -= Segment P  Morev
Catalog 01.01.1900 - 31.12.9999 01 Current plan
LEI QK 50085100 [] Government Of Brunei Darussalam 00000002 Standard qQuality Scale (0-9)
0 QK 50085101 [] General 00000002 standard Quality Scale (0-9)
2 QK 50085102 [] Ministry Specific Qualification 00000002 standard Quality Scale (0-9)
QK 50085436 [] Pejabat Suruhanjaya Perkhidmatan Awam 00000002 standard Quality Scale (0-9)
fa QK 50085103 [J Skim Perkhidmatan Requirement 00000002 standard Quality Scale (0-9)
0 QK 50085136 [] UAT Testing Data 00000002 standard Quality Scale (0-9)

SSM_UG_SP_Back End (SAP GUI)_JPA_v1.0 15
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Note: User may click on the Folder button to show or hide the items within the folder.

2. Select the group in which the user would like to create a new Qualification Group into.

3. Click on the Create icon.

Catalog: Change Qualification(s)

= | < povit®
3
v Q W =™ A~ v % ¥ A o= Posion
Catalo 01.01.1900 - 31.12.9999 01 Current plan

2

a

= 50085100 Tg Government Of Brunei Darussalam
|

_

—C0 QK 50085101 [] General

—Ca QK 50085102 [] Ministry Specific Qualification

QK 50085436 [] Pejabat Suruhanjaya Perkhidmatan Awam

—Ca QK 50085103 [] Skim Perkhidmatan Requirement
—a QK 50085136 [] UAT Testing Data

Note: A view page to Create ‘Qualification’ and ‘Quialification Group’ will be displayed.

00000002
00000002
00000002
00000002
00000002

ElV < SAP
Vi@ 1 W = oA v B % A s= Position
Catalog 01.01.1900 - 31.12.9999 01 cCurrent plan

LP_‘I QK 50085100 [] Government Of Brunei Darussalam

fa QK 50085101 [] General
0 QK 50085102 [] Ministry Specific Qualification

QK 50085436 [] Pejabat Suruhanjaya Perkhidmatan Awam
fa QK 50085103 [] Skim Perkhidmatan Requirement

G0 QK 50085136 UA
& = = Create X

Qualification

Qualification group

00000002
00000002
00000002
00000002
00000002

4
11}

Segment P More v

00000002 standard Quality Scale (0-9)

Standard Quality Scale (0-9)
Standard Quality Scale (0-9)
Standard Quality Scale (0-9)
Standard Quality Scale (0-9)
Standard Quality Scale (0-9)

Catalog: Change Qualification(s)

5= Segment i  Morev

00000002 Standard Quality Scale (0-9)

Standard Quality Scale (0-9)
Standard Quality Scale (0-9)
Standard Quality Scale (0-9)
Standard Quality Scale (0-9)
Standard Quality Scale (0-9)

SSM_UG_SP_Back End (SAP GUI)_JPA_v1.0
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4. Click on ‘Qualification Group'.
5. Click on the Tick icon.
= Create X
Qualification
Qualification group
Note: A view page to ‘Create Qualification Group’ will be displayed.
5| v < A Catalog: Change Qualification(s)
v @ ] W =™ A v B ¥ A += Posiion = Segment P Morewv
- = Create Qualification group X
Catalog 01
B (B[ SOOI ) e Qualification group Proficiencies r scale (0-9)
2 QK 50085101 [] Gener 1lity Scale (0-9)
5 QK 50085102 [] Minis ¢ 0 ity Scale (0-9)
QK 50085436 [] Pejak | | 1lity Scale (0-9)
fa QK 50085103 [] skim 1lity Scale (0-9)
= e O Valid from: |01.01.1900 t0731.12.9999 e e L
Description
Q IL
<> <2 N
* Scale: Standard Quality Scale (0-9) v
<> Glsave X « f]
SSM_UG_SP_Back End (SAP GUI)_JPA_v1.0 17
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6. Fill the Qualification Group Name.
Note: User may set the Valid from and to dates and the Description.
7. Choose the Scale related to the Qualification Group.
8. Click on the Proficiencies tab.
= Enuy Edit Goto View Settings System Help > GHQ (1) 200 | 7 x
SAP4 Catalog: Change Qualification(s)
d L = 7 Create Qualification group A X jore™ 3>

Catalog B e1.¢ z
Qualification group Proficiencies

3 gK 50073001 [] Government

0 oK 50073002 [ General oK 0 3)
0K 50073028 [1 Min. of |5 eyel subjects q 2
02 oK 50073027 [1 Min. of 2
QK 50073033 [] Ministi @
—@ ok 50073610 [] Minist: I\fard from: 01.01.1900 to: 31.12.9999 B
(9 QK 50073013 [J Ministi Description 2
—CD QK 50073009 [] Minist) 3)
QK 50073015 (] Ministi 3)
—CD QK 50073007 [] Minist) 3)
03 oK 50073006 (] Ministi 3)
63 oK 50073008 (] Ministi 5)
02 QK 50073003 [ Minist) 3)
0 oK 50073050 (] O Level q
—00 QK 50073011 [] Prime # *Scale Ives Scale v 5)

Note: A view page of the Proficiencies tab will be displayed.

= Create Qualification group X
Catalog 01.01.1900 - 31.12.999¢

LE QK 50085100 [] Government Of Brunei Darussala qualification group Proficiencies

[0 QK 50085101 [] General

8 QK 50085102 [] Ministry Specific qQualific v] Default
QK 50085436 [] Pejabat Suruhanjaya Perkhi Proficiencies @
A QK 50085103 [] sSkim Perkhidmatan Requiremr D Proficiency
G0 QK 50085136 [] UAT Testing Data N
-
<> ‘ ):

Description of current proficiency

|«

. Esave R « (]

SSM_UG_SP_Back End (SAP GUI)_JPA_v1.0 18
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9. Choose the default proficiency for the new Qualification Group.
10. Click on the Save button.
11. Click on the Tick icon.

Create Qualification group X

Qualification group Proficiencies

v| Default

Proficiencies &
9 i) Proficiency

T o

a a

<> <o

Description of current proficiency

|«

10 11
Esave X « f]

Outcome: A new Qualification Group has been saved.

nAR% L4 A Catalog: Change Qualification(s)

Vi@ ([ W & A~ v B ¥ A -=Posion -5 Segment §® Morev

Catalog 01.01.1900 - 31.12.9999 01 Current plan
LB QK 50085100 TZF Government Of Brunei Darussalam 00000002 Standard Quality Scale (0-9)
L]
—Ca QK 50085101 [] General 00000002 Standard Quality Scale (0-9)
—Ca QK 50085102 [J Ministry Specific Qualification 00000002 Standard Quality Scale (0-9)
QK 50085533 [] O Level Subjects 00000003 Yes Scale
QK 50085436 [] Pejabat Suruhanjaya Perkhidmatan Awam 00000002 Standard Quality Scale (0-9)
—Ca QK 50085103 [] sSkim Perkhidmatan Requirement 00000002 standard Quality Scale (0-9)
—Co QK 50085136 [] UAT Testing Data 00000002 Standard Quality Scale (0-9)

SSM_UG_SP_Back End (SAP GUI)_JPA_v1.0 19
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MAINTAIN Backend User

QUALIFICATION

Log into SAP GUI (Back End) and proceed with the following steps.

1. Enter transaction code OOQA in the search bar.

SAP Easy Access

[ oo0A TI H = & S othermenu W * S Vv A E Createrole Morev

[Eraered

~ 13 SAP Menu
> [ Connector for Multi-Bank Connectivity
> [ Office
> [ Cross-Application Components
> [ Logistics
> [[3J Accounting

» [ Human Resources

> [ Information Systems

> [ Service

> [O Tools

> [J WebClient Ul Framework

Note: Catalog: Change Qualification(s) will be displayed.

< B B %
- < W Catalog: Change Qualification(s)
a 0 AV ¥ A = Posiion = Segment @  More ™ Q  FindNext & Exit
lcatalog T 01.01.1900 - 31.12.9999 01 current plan

1 [0 Government Of Brunei Darussalam

SSM_UG_SP_Back End (SAP GUI)_JPA_v1.0 20
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Note: User may navigate to More > View > Key on: Additional data on to show the Object

ID of the catalog items and its scale.

=| v < hE‘ '? Catalog: Change Qualiﬁ(s)
via (1 W & A v B ¥ A = Posion o= Segment § Q  Find
Cancel (F12)
catalog 01.01.1900 - 31.12.9999 01 Current plan Entry >
L Edit >
= [J Government Of Brunei Darussalam Goto
I View > Key on (Ctrl+F7)
o [ General -
@ [J Ministry Specific Qualification Settings >
] Pejabat Suruhanjaya Perkhidmatan Awam System > Additional data on  (Ctri+F6)
a [ Skim Perkhidmatan Requirement Help > Switch Layout ‘
o [J UAT Testing Data . .
SAP GUI settings and actions > Color Legend (Shift+Fa)
Note: The Object ID of the catalog items and its scale system will be displayed.
= v < ALK Catalog: Change Qualification(s)
v Qe [ W @ A v B ¥ A = Position -= Segment P  Morev
Catalog 01.01.1900 - 31.12.9999 01 Current plan
LEI QK 50085100 [] Government Of Brunei Darussalam 00000002 Standard qQuality Scale (0-9)
0 QK 50085101 [] General 00000002 standard Quality Scale (0-9)
2 QK 50085102 [] Ministry Specific Qualification 00000002 standard Quality Scale (0-9)
QK 50085436 [] Pejabat Suruhanjaya Perkhidmatan Awam 00000002 standard Quality Scale (0-9)
fa QK 50085103 [J Skim Perkhidmatan Requirement 00000002 standard Quality Scale (0-9)
0 QK 50085136 [] UAT Testing Data 00000002 standard Quality Scale (0-9)
21
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Note: User may click on the Folder button to show or hide the items within the folder.
2. Select the group in which the user would like to create a new Qualification into.
3. Click on the Create icon.
=/ v < SAF Catalog: Change Qualification(s)
3
v W = A v B ¥ A = Posion = Segment @ Morev
Catalog 01.01.1900 - 31.12.9999 01 Current plan
= RK 50085100 [] Government Of Brunei Darussalam 00000002 Standard Quality Scale (0-9)
—Ca QK 50085101 [] General 00000002 standard qQuality Scale (0-9)
0 QK 50085102 @M Ministry Specific Qualification 00000002 Standard Quality Scale (0-9)
QK 500355330 Level Subjects 00000003 Yes Scale
QK 50085436 [] Pejabat Suruhanjaya Perkhidmatan Awam 00000002 Standard Quality Scale (0-9)
—Ca QK 50085103 [] Skim Perkhidmatan Requirement 00000002 standard qQuality Scale (0-9)
—rCo QK 50085136 [] UAT Testing Data 00000002 Standard Quality Scale (0-9)
Note: A view page to Create ‘Qualification’ and ‘Qualification Group’ will be displayed.
5| v < SAF Catalog: Change Qualification(s)
v ([ W o#ZoA v B ¥ A s= Positon = Segment i Morev
catalog 01.01.1900 - 31.12.9999 01 Current plan
L|1_‘| QK 50085100 [] Government Of Brunei Darussalam 00000002 Standard Quality Scale (0-9)
o QK 50085101 [] General 00000002 Standard Quality Scale (0-9)
—Ca QK 50085102 [] Ministry Specific Qualification 00000002 Standard Quality Scale (0-9)
QK 50085533 [] O Level Subjects 00000003 Yes Scale
QK 50085436 [] Pei-~h~+ curuhaniaua Barlkhidmaran fuam 00000002 standard Quality Scale (0-9)
= QK 50085103 [] Sk = Create X 00000002 Standard Quality Scale (0-9)
—ra QK 50085136 [] UA 00000002 Standard Quality Scale (0-9)
Qualification
Qualification group
v X
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4. Click on ‘Qualification’.
5. Click on the Tick icon.
v < SAF Catalog: Change Qualification(s)
vi@a (] W &% A v B ¥ A -=Posion = Segment P  Morev
Catalog f9 01.01.1900 - 31.12.9999 01 Current plan
LE QK 50085100 [] Government Of Brunei Darussalam 00000002 standard Quality Scale (0-9)
00 QK 50085101 [] General 00000002 Sstandard Quality Scale (0-9)
—08 QK 50085102 [] Ministry Specific Qualification 00000002 Standard Quality Scale (0-9)
QK 50085533 [] O Level Subjects 00000003 Yes Scale
QK 50085436 [] Pei~h~+ cumihaniaua Danbhidmatan Auwnm 00000002 Standard Quality Scale (0-9)
0 QK 50085103 [] sk = Create X 00000002 standard Quality Scale (0-9)
L —@ QK 50085136 [] UA 00000002 Standard Quality Scale (0-9)
I Qualification
Qualification group
. . ‘ . . , . .
Note: A view page to Create ‘Qualification’ will be displayed.
= > GHOM210 [ 5 _ 5 X
nihd L SAH Catalog: Change Qualification(s)
v o ] W Z A v ¥ A +& Position +F Segment @ More v Q  FindNext &  Exit
= Create Qualification X -
catalog = 01.01.1900 - 31.
[ QK 50085100 [] Government Of Brunei pa Cualification Proficiencies  Addit. Data
00 QK 50085101 [] General Q 0 0
(3 OK 50085102 [] Ministry Specific Q@ = 1 9
K 50085533 ] 0O Level Subjects b '
K 50085436 [] Pejabat Suruhanjaya 9
7 QK 50085103 [ skim Perkhidmatan R Valid from: 01.01.1900 10 31.12.,9999 9
0 QK 50085136 [] UAT Testing Data Description 9
Y oy

<> <

Qualification group: O Level Subjects

Scale: Yes Scale

(& Save

SSM_UG_SP_Back End (SAP GUI)_JPA_v1.0
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6. Fill the Qualification Name.
7. Click on the Proficiencies tab.
= Catalog: Chang > GHQ (1) 200 & _ = X
< E; J Catalog: Change Qualification(s)
v a a w® - - Yore v Q  FindNext & = v Exit
= Create Qualification X
Catalog B e1.¢ *
Qualification Proficiencies Addit. Data
X1 QK 50073001 [] Government R
01 oK 50073002 [] General g_o 3)
QK 56073028 [] Min. of I Bahasa Melayu 2
(A QK 50073027 [] Min. ot 8
QK 50073033 [] Ministi
a1 QK 50073010 [J Ministl Valid from: | ©1.81.1900 tor 31.12.9999 3
QK 50073013 [] Ministi Description 2
03 oK 50073009 [1 Ministi 3)
QK 50073015 [] Minist R 3)
03 oK 50073007 [] Minist v 3)
—0G1 oK 50073006 [] Ministi 3)
QK 50073008 [] Ministi 5)
071 oK 50073003 [] Ministi 3)
—C2 ok see73ese [J O Level v
(9 QK 58073011 [] Prime } Qualification group: O Level Subjects 3)
Scale:  Yes Scale
= > GHomz2w [ § _ T X
b L SAE Catalog: Change Qualification(s)
v @& 1] W Oz A v By ¥ A oF Posion -+F Segment § Morew Q  FindNext @&  Exit
= Create Qualification X -
catalog F7 01.01.1900 - 31.

LE QK 50085100 [] Government Of Brunei pa Qualfication Proficiencies ~ Addit. Data

0B QK 50085101 [] General 7 Detault 9)

00 QK 50085102 [] Ministry Specific Q N 9)
Proficiencies @

——QK 50085533 [] 0 Level Subjects -

| aK 50085436 [] Pejabat Suruhanjaya |10 | Froficiency 9)

—co QK 50085103 (] Skim Perkhidmatan R > 1 Yes 9)

0o QK 50085136 [] UAT Testing Data 2

<> v

Description of current proficiency
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8. Click on to choose default proficiencies for the Qualification (if needed).
9. Click on the Addit. (Additional) Datatab.
= » GHOM210 [ & -0 X
™ < W Catalog: Change Qualification(s)
catalog F 01.01.1900 - 31. = crene e :

Addit. Data

I‘.o

) QK 50085100 [] Government Of Brunei pa Qualification Proficiencies

@0 QK 50085101 [ General ¥ Defaul 9)

—0a QK 50085102 [] Ministry Spe.clﬁc Q Broficiencies ® i3]
QK S0085533 [J O Level Subjects >

|——aK 50085436 [ Pejabat Suruhanjaya oM | Eietoenoy )

—0a QK 50085103 [J Skim Perkhidmatan R Yes 9

“—0@ QK 50085136 [] UAT Testing Data i3]

Description of current proficiency

Note: A view page of the Addit. (Additional) Data tab will be displayed.

> GHa(y210 (B § _ & X

E1 < ..E! " Catalog: Change Qualification(s)
¢

Position »= Segmemt @ More v Q. FindNext &  Exit

a4 0 W & A v B ¥ A

ate Qualifica x
catalog = 0 Create Qualification

= [ il i Gl Qualification Proficiencies Addit. Data

ta [] General

m [] Ministry specific IDeprecwal'loﬂ Meter v Years
@ K O Level Subjects Months
Pejabat Suruhanjz
o ] Skim Perkhidmatar .
- Altemative Quals @
£ [] UAT Testing Data
Alternative Qual. Percrate Start
o oo
@le

E)save 3
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10. Choose Depreciation Meter or Validity (if needed).
11. Fill Years or Months (if needed).
Note:
» Depreciation Meter: Qualification Proficiency will decrease following those dates.
+ Validity: Qualification Validity will follow those dates.
12. Click on | = | to add alternative qualification.
Note: Alternative qualification is used to represent more than one qualification.
= Entry Edit Goto View Settings System Help > GHQ (1) 200 o _ | x
EE: ’ Catalog: Change Qualification(s)
v f] w - - lore v Q FindNext & |5 v Exit
= Create Qualification X
Catalog B e1.¢ -
Qualification Proficiencies Addit. Data
3 QK 50073001 [] Government
08 QK 50073002 [] General IDepreciatian Meter | Years 3)
QK 50073028 [] Min. ot Months 2
00 QK 58073027 [] Min. of 2
0K 50073033 [] Ministi
—01 ok 56073010 [J Ministi Alternative Quals @ 2
(0 QK 50073013 [] Ministi Altemative Qual. Perc.rate  Start 2
03 0K 50073009 [] Ministi - 3)
QK 50073015 [] Ministi 3)
00D oK 50073007 [ Ministi 3)
00 QK 50073006 [] Ministi 3)
00 oK 50073008 [] Ministi 5)
[0 QK 50073003 [] Ministi 3)
—0E QK 50073050 [0 0 Level N
'—(3 QK 50073011 [1 Prime b v 5)
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Note: A view page to Choose Qualification will be displayed.
= > GHa(nz210 [ & -0 X
== Choose Qualification X in(s)

Goverment OF
General

Ministry Spe

Skim Perkhid

OK 50085533 v
Malay Literature] 0 50085583 Malay Litera
32 | Bahasa Melayu Q 50085584 Bahasa Melay

13. Select a Quialification Alternative.

Note: Choose alternative Qualification with the same Proficiency.
14. Click on the Tick icon.

= Choose Qualification X P S o _ 5 x
Name 1o Code Ve ~ Q  FindNext & S|V Exit
> [ Ministry Specific Qualification Ministry Spe 010,

» [ Ministry of Religious Affairs Ministry of 01.0 :
> [ Ministry of Energy Ministry of 01.0
2 [ Ministry of Religious Affairs Ministry of 01.0
» [ Ministry of Education Ministry of 01.0
» [ Ministry of Development Ministry of 01.0
» [ Prime Minister's Office Prime Minist 01.0
» [ Ministry of Development Ministry of 01.0
[ Ministry of Education Ministry of 010
> [ Min. of Foreign Affairs sC 01.0
[ Min. of Finance & Economy SD 01.0
[ Ministry of Culture, Youth and Sports Ministry of 01.0
~ 19 O Level Subjects O Level 01.0
¥ Bahasa Melayu L Bahasa Melay 01.0
¥  Bahasa Melayu Bahasa Melay 01.0
2 English Language English Lang 01.0
¥  wMathsD Maths D 01.0
¥  Biology - Biology 01.0
B Physics Physics 01.0
n Chemistry 01.0
Malay Litera 01.0
" Rhowledge . Islamic Reli 01.0

®  History History 010 :
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15. Fill Percentage rate as desired for alternative qualification.
Note: Minimum and Maximum percentages are 0 and 100 respectively.
16. Click on Save button.
17. Click on the Tick icon.
= Catalog: Change Qualification(s) > GHQ (1) 200 & _ 7 X
< E : J Catalog: Change Qualification(s)
voa 1 W B - tore Vv Q  FindNext & S|V | Exit
= Change Qualification X
Catalog M oe1.c hd
Qualification Proficiencies Addit. Data
(SN =3 [J Government
—&E 20 [0 General Depreciation Meter ~ Years 3)
[} B[] Min. ol Months 2
—E . BF 0 Min. o1 2
- - 2 0 Ministi
—E - = b [0 Ministi Alternative Quals 15 & B
(7 v O Minist) Altemative Qual. Perc.rate |Start 2
2 .. ® [ Ministi Malay Literature 100.00p1.01.1900 © 3
— ® F O Ministi 3)
— wo= [] Minist) 3)
—rmm P O Ministi 3)
—Ca B[O Minist) 5)
& . Bk O ministi 3)
= ' O 0 Level )
—E . =@ i 0 Prime b < <> v 5)

Outcome: A new Qualification has been saved.
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MASS UPLOAD Backend User

QUALIFICATION GROUP [N

Log into SAP GUI (Back End) and proceed with the following steps.

1. Enter ZHCMSPO001_MASS in the search bar.

IIf
~
®
|
]
X

»!‘ J SAP Easy Access
1
ZHCMSPOO1 MASS  ~ |E @ & & Othermenu W & 7 v A B Createrole  More™ Q o @ Exit

> [ Favorites
~ T SAP Menu
> [] Connector for Multi-Bank Connectivity
> [ office
» [ Cross-Application Compaonents
» [ Logistics
» [ Accounting
> [1Human Resources
> [ Information Systems
> [ service
> 1 Tools
> [11webClient Ul Framework

Note: Mass Upload Qualification Catalog will be displayed.

Lo R 4

< y Mass Upload Qualification Catalog

~ Save as Variant...  More™ Exit
Mass Upload Qualification Catalog
Qualification Group: @

Qualification:

* File:

SSM_UG_SP_Back End (SAP GUI)_JPA_v1.0 29



Sistem Sumber Manusia - Succession Planning ‘74'
2. Choose Qualification Group.
= < B -8 %
< '-i:‘ " Mass Upload Qualification Catalog
~ Save as Variant...  More™ Exit

Mass Upload Qualification Catalog 2

Qualification

* File

3. Click on the Lookup icon.

< K : 'J Mass Upload Qualification Catalog

v (5 saveasVariant.. More Exit

Mass Upload Qualification Catalog
Qualification Group: (®

Qualification: 3
(s 3

* File:
e 4

I}
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Note: List of Document will be displayed.

Y
0
£ " %
B N
%, S

v, S
Unpen ™

Open
Lookin' | =L Documents

:“ Name

Quick access

v e P E

Desktop
m

Mass Upload Qualification Catalog
Libraries

Date modified

5/23/2022 10:14 AM

&

This PC

Network

<3

File name:

>

Files of type: All Files (*.)

Mass_Upload_Qualification_Cataleg

Open
Lookin | =k Documents v | @&
:“ Name Date modified
Quick access
Desktop
.I'I i85 Mass Upload_Qualification Catalog 5/23/2022 10:14 AM
Libraries
This PC
Network .
4
File name: Mass_Upload_Qualification_Catalog v
Files of type: All Files (*%) ~ Cancel

SSM_UG_SP_Back End (SAP GUI)_JPA_v1.0

Open

Cancel

4. Choose specific file for Qualification Group template and click the Open button

X
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5. Once uploaded, clickthe Execute button.
= ) 8 X
3 sang

Mass Upload Qualification Catalog

v (@ save as Variant More v

Exit
Mass Upload Qualification Catalog

Qualification Group: @

Qualification:

r a
“ File: |hd\Documents\Mass_Upload_Qualification_catalog.xlIsx (Il
L 4

|

Note: A pop-up window for SAP GUI Security will be displayed.

SAP GUI Security

The system is trying to access the file
C:\Users', :
\DOCUMENTS\MASS_UPLOAD_QUALIFICATION_CATALOG.XLSX

Do you want to grant access to this file?

Remember My Decision

Allow Deny

SSM_UG_SP_Back End (SAP GUI)_JPA_v1.0

32



Sistem Sumber Manusia - Succession Planning ‘74'

6. Click the Allow button.

SAP GUI Security X

The system is trying to access the file

C:\Users', )
\DOCUMENTS\MASS_UPLOAD_QUALIFICATION_CATALOG.XLSX

Do you want to grant access to this file?

Remember My Decision

Allow | Deny Help

Note: List of Qualification Group will be displayed.

= <& _8 x
< W Mass Upload Qualification Catalog
v @ & F ¥V fx (w L & EXPORT Morev Q @ Exit
Indicator Status Abbr. Object name Start Date End Date Object ID Scale Object ID Msg. Var. Msg. Var. Msg. Var. Msg. Var.
:v: SC  Min. of Foreign Affairs 01.01.1900 31.12.9999 50000025 48
v SD  Min. of Finance & Economy 01.01.1900 31.12.9999 50000025 48
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7. Tick the Qualification Group desired to be added.

Mass Upload Qualification Catalog

va &2 T YV & w L @
Start Date End Date

btatus Abbr. Object name
SC  Min. of Foreign Affairs
SD  Min. of Finance & Economy 01.01.1900

01.01.1900 31.12.9999

8. Then click the Export button.

EXPORT More

Object ID Scale Object ID Msg. Var. Msg. Var. Msg. Var. Msg. Var.

50000025 48
31.12.9999 50000025 48

v a = = G
Indicator Status Abbr. Object name Start Date End Date
) SC  Min. of Foreign Affairs  01.01.1900 31.12.9999
i
v SD  Min. of Finance & Economy 01.01.1900  31.12.9999

More

Obiject ID Scale Object ID Msg. Var. Msg. Var. Msg. Var. Msg. Var.

50000025 48
50000025 48

34
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Outcome: Qualification Group to Qualification Catalog has been successfully exported.

[ R I
< K :‘ 'J Mass Upload Qualification Catalog
Q@ =& F V (x (w L @& EXPORT Morev Q B e
Indicaf] Status Ab  Object name Start Date End Date Object ID Scale Object ID Msg. Var. Msg. Var. Msg. Var. Msg. Var.

=
v, W syccess SC  Min. of Foreign Affairs 01.01.1900  31.12.9999 500000 48

C

v | ®success SD Min. of Finance & Economy 01.01.1900  31.12.9999 500000 48
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MASS UPLOAD Backend User

QUALIFICATION

Log into SAP GUI (Back End) and proceed with the following steps.

1. Enter ZHCMSPO001 MASS in the search bar.

IIf
~
®
|
]
X

»!‘ J SAP Easy Access
1
ZHCMSPOO1 MASS  ~ |E @ & & Othermenu W & 7 v A B Createrole  More™ Q o @ Exit

> [ Favorites
~ 3 SAP Menu
> [*1 Connector for Multi-Bank Connectivity
> [0 office
> [ Cross-Application Components
» (1] Logistics
» [ Accounting
> [1Human Resources
> [ Information Systems
> [ service
> 1 Tools
> [11webClient Ul Framework

Note: Mass Upload Qualification Catalog will be displayed.

Lo R 4

< y Mass Upload Qualification Catalog

~ Save as Variant...  More™ Exit
Mass Upload Qualification Catalog
Qualification Group: @

Qualification:

* File:
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Sistem Sumber Manusia - Succession Planning ‘74'
2. Choose Qualification.
= (& 3 X
< w Mass Upload Qualification Catalog
- Save as Variant...  More™ Exit

Mass Upload Qualification Catalog

* File: o
L

3. Click on the Lookup icon.

< E : 'J Mass Upload Qualification Catalog

v (5] save as variant More Exit

Mass Upload Qualification Catalog
Qualification Group: (®

Qualification
=

" File
s
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Note: List of Document will be displayed.

bR,
&
£ " %
) <N
~, S

v, S
Unpen ™

Open

Lookn (£ Documents

:" Name

Quick access

v

!1.7 })

Desktop
m

Mass _Upload Qualification Catalog v1.0
Libraries

Status

Dat.. ~

L

This PC

Network

<3

File name:

5/23/2C

Files of type: All Files (*.%)

Open

Lockin: [ Documents

Mass_Upload_Qualification_Catalog_v1.0

~

<| EPmE-
i Name

Quick access

Desktop
m

Mass_Upload_Qualification Catalog v1.0
Libraries

Status

Dat ..

©
=

This PC

@

Network

<5

File name:

-

5/23/2(C

Mass_Upload_Qualification_Catalog_v1.0
Files of type:

AV
Al Files ()

SSM_UG_SP_Back End (SAP GUI)_JPA_v1.0
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Cancel

Open

Cancel

4. Choose specific file for Qualification Group template and click the Open button

X
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5. Once uploaded, clickthe Execute button.

= & — & x
< v-:E: ? Mass Upload Qualification Catalog
B Save as Varant More .
Mass Upload Qualification Catalog
L
* File
5
Execute

Note: Pop-up window for SAP GUI Security will be displayed.

SAP GUI Security X

The system is trying to access the file

C:\Users\,
\DOCUMENTS\MASS_UPLOAD_QUALIFICATION_CATALOG_V1.0.XLSX

Do you want to grant access to this file?

Remember My Decision

Allow Deny Help
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6. Click on the Allow button.

SAP GUI Security X

The system is trying to access the file

C:\Users\
\DOCUMENTS\MASS_UPLOAD_QUALIFICATION_CATALOG_V1.0.XLSX

Do you want to grant access to this file?

Remember My Decision

Allow I Deny Help

Note: List of Qualification will be displayed.

< b: : J Mass Upload Qualification Catalog

Y I (x (w 1 @ EXPORT Morev

v @

Indicator Status Abbr. Object name Start Date  End Date Object ID DM/Valid. Years Months Object ID Msg. Var. Msg. Var. Msg. Var. Msg. Var.
r\/-‘ Exp 01 Experience 01 01.01.1900 31.12.9999 50085136 0 o

La
v Exp 02 Experience 02 02.01.1900 31.12.9999 50085136 0 0
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7. Check the Qualification Group desired to be added.

(B 8 x

Mass Upload Qualification Catalog
Exit

A
la
ol

il

[ & EXPORT Morev

v oI (x (w L

v @
End Date Object ID DM/Valid. Years Months Object ID Msg. Var. Msg. Var. Msg. Var. Msg.
31.12.9998 50085136
31.12.9999 50085136

Btatus Abbr.  Object name  Start Date
0 0

Exp 01 Experience 01 01.01.1900
[} o

Exp 02 Experience 02 02.01.1900

8. Then click on the Export button.

(B 8 x

ification Catalog

Mass Upload Q

EXPORT

Object ID DM/Valid. Years Months Object ID Msg. Var. Msg. Var. Msg. Var. Msg. Var.

Exit

Jo)
i

L sand

More ™~

VoI x w i @&

Q
Y

Indicator Status Abbr. Object name Start Date  End Date
") Exp 01 Experience 01 01.01.1900 31.12.9999 50085136 0 0
La

31.12.9999 50085136 0 0

v Exp 02 Experience 02 02.01.1900

41
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Outcome: Qualification Group to Qualification Catalog has been successfully exported.

< K :‘ 'J Mass Upload Qualification Catalog

Q

I (x fw L @& EXPORT Morev

Indicaf] Status Abbr. Object name  Start Date End Date
v -Success Exp 01 Experience 01 01.01.1900

Object ID DM/Valid. Years Months Object ID Msg. Var. Msg. Var. Msg. Var. Msg. Var.
31.12.9999 500851

31129999 500851

0 0500855
4 L] Success

Exp 02 Experience 02 02.01.1900

0 0 500855

SSM_UG_SP_Back End (SAP GUI)_JPA_v1.0
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ASSIGN QUALIFICATION Backend User

Log into SAP GUI (Back End) and proceed with the following steps.

1. Enter PPPM in the search bar.

> GHO()210 [ & 5 X

r-!- 'J q SAP Easy Access
o | © = s omemew % A £ v A B Cesermie Moo Q@ @ e

» [ Favorites
~ 13 SAP Menu
» [ Connector for Multi-Bank Connectivity

» [ Office
» [ Cross-Application Components
> [ Logistics

> [7) Accounting

1 Human Resources
[ Information Systems
» [0 Service
> [ Tools
» [ WebClient Ul Framework,

Note: Change Profile Page will be displayed.

> GHOM210 [ & | — & X

< W User: Change Profile (29.05.2022 - 31.12.9999)

B CareerPlanning ¢ CurrentPosition  More =  Exit

¥][a e

] | 2005.2022 to: 31.12.9999
Find by

> g2 Person

> WJ User

» 22 Applicant

> & Position

& Job

Planvel-;ion'L‘urre-mp\.an'wa-;se( Savey Continue Cancel
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2. Click on the dropdown for Job.

3. Click on Search Term button.

&/ X

> GHa2 [ &
. SAR¢

User: Change Profile (29.05.2022 - 31.12.9999)
| & Career Planning  SE Current Position ~ More

& Bat
VIIPY
= /| 20052022 tc
Find by

0: 31.12.9999
> £4 Person

» W User

bl jcant

2 jon
3
» = Organizational unit

> & Task

> Requirements profile (LO)

Savel Continue Cancel

Note: A view page of Find Job will be displayed.
4. Enter the With name: field with (*) or a specific name

5. Click on the Find button.

_ 5 x

> GHa()210 [ &
< »3: 7 User: Change Profile (29.05.2022 - 31.12.9999)

& CareerPlanning & Current Position  More

& Exit
Find Job

B |29.05.2022 to: 31.12.9999
I With name: |* |

Save Continue Cancel
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Note: A list of Job will be displayed under Hit list.

6. Double click on a specific Job on the Hit list.

GHO()210 Bl & _ O X

< s User: Change Profile (29.05.2022 - 31.12.9999)

& Career Planning  f Current Position ~ More v &  Exit

», Y A

Find by
> & Person

& User

22 Applicant

& Position

7 Job

2 Search Term

W Organizational unit

2 Task

[x] i profile (LO) = -
Hit list

sl EEF 2B [

Cod_e D Valid from Valid t
Superscale A C 20000000 01.01.2010 Unlimited

Superscale A

uperscale uperscale W Intimi
Superscale C Superscale C C 20000002 01.01.2010 Unlimited

1 P 1C 01.01.2010 Unlimited
Kumpulan 2 Kumpulan2 C 20000004 01.01.2010 Unlimited
Kumpulan 3 Kumpulan3 C 20000005 01.01.2010 Unlimited
PGUA4 PGUA C 20000006 01.01.2010 Unlimited
PGU3 PGU3 C 20000007 01.01.2010 Unlimited
PGU2 PGU.2 C 20000008 01.01.2010 Unlimited

Note: Job Requirement Page will be displayed.

7. Click on the Create Icon.

= > GHa(n210 [ & -0 X

R v <« SAF Job: Change Profile (29.05.2022 - 31.12.9999)

&' Succession Planning  More v & Exit

* ¥ A -
7 | 29.05.2022 to: 31.12.9099
Find by
> # Person 2| Job Superscale A
> User Start: 01.01.2010 - 31.12.9999
&5 Applicant
2 Position
~ E] Job Requirements
4 Search Term -
> [ Organizational unit
0T Qualification group Name St.. Proficiency Ess Start End Date

> 2 Task | !
> €3 Requirements profile (LOY ___ > ‘| ) N
Hit list
slall & = v 2 |Bv | &
Name Code D Valid from Valid 1
Superscale A Superscale A C 20000000 01.01.2010 Unlimi _
Superscale B Superscale B C 20000001 01.01.2010 Unlimi
Superscale C Superscale C C 20000002 01.01.2010 Unlimi n
Kumpulan 1 Kumpulan 1  C 20000003 01.01.2010 Unlimi @ 1L
Kumpulan 2 Kumpulan 2 C 20000004 01.01.2010 Unlimi a|:=|s= W | TS =|F| (&8O
Kumpulan 3 Kumpulan 3 C 20000005 01.01.2010 Unlimi
PGU4 PGUA4 C 20000006 01.01.2010 Unlimi
PGU3 PGU3 C 20000007 01.01.2010 Unlimi .
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= > GHaW210 B & | — 5 %
et L4 [ 'J Job: Change Profile (29.05.2022 - 31.12.9999)
v | B Succession Planning  More &  Exit
= ition {1 * £ | 20052022 to: 31.12.9999
S: Search Term T: Structure Search | C: Abbreviation and NameR: Searc... >,
Search Term:| Bl *
- 31.12.9999
B
> [ Organizational unit
5 Task Qualification group Name St...  Proficiency Ess Start End Date &
€ Requirements profile (LO) . :
Hit list
& a| | =] =] [V 2 B v |
Name Code (] Valid from  Valid 1
Superscale A Superscale A C 20000000 01.01.2010 Unlimi _
Superscale B Superscale B C 20000001 01.01.2010 Unlimi
Superscale C Superscale C C 20000002 01.01.2010 Unlimi R
Kumpulan 1 Kumpulan1 C 20000003 01.01.2010 Unlimi £3 L)
Kumpulan 2 Kumpulan 2 C 20000004 01.01.2010 Unlimi (| |0|W|L(is| |&|F||= |2
Kumpulan 3 Kumpulan 3 C 20000005 01.01.2010 Unlimi
PGU4 PGU.4 C 20000006 01.01.2010 Unlimi
PGU3 PGU3 C 20000007 01.01.2010 Unlimi -
== i = el re el

Note: Qualification Catalog will be displayed.

9. Click onthe Dropdown button next to the Folder icon to reveal its contents
10. Click on a qualification to selectit.

Note: More than one qualification can be added at a time.

11. Click on the Tick Icon.

> GHA(N210 [ & | — 5 X
N = Choose Qualification X 11.12.9999)
S Exit
D Code
- 3 | 20.05.2022 to: 31.12.9999
Find General
> &
>m
I
> 8 Perfor
= i ality Nationality
runeian Bruneian
> - [CJCEP CEP -
o St.. Proficiency Ess Start End Date
> & > [ CSLP Flagship Program CSLP Flagshi :
La Languange N
csl ol

K. Peperiksaan
S etahuan tentang kerasmia QK 5 E Pengetahuan
Pengetahuan tentang kerasmian Q 50085406 Pengetahuan

Supe

P » [0 Bachelor Degree QK 7 Bachelor Deg|
Supe
Supe .
Kumj <> <rw
Kumj
Kumy > [ Tempoh Memangku
PGU

» [J Education with Credit

[ Ministry Specific Qualificatio

Save Continue Cancel
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Note: You will be navigated back to the Job Requirement Page with the chosen qualifications.

12. In one of the qualifications, under Proficiencies, click on Lookup icon.

n

> GHa(D210 (] & g8 X
< y Job: Change Profile (29.05.2022 - 31.12.9999)

& Succession Planning  More v/

* ¥ A - T
E| to: 31.12.9999
Find by
#2 Person 2 Job Superscale A
S Start: 01.01.2010 - 31.12.9999
2% Applicant
&, Position
] Job Requirements
4 Search Term T
= Organizational unit s
9 Task Qualification group Name St.. Proficiency Ess Start End Date
> éRequivemems profile (LO) : Nationality Bruneian Yes 12 29.05.2022 31.12.999¢%
Hit list H tentang i E tentang I Yes 29.05.2022 31.12.999¢
® 2 = | Iy =N e [ Performance Appraisal erformance Result IS aj | . 29.05.2022 31.12.999¢
Name Code D Valid from Valid t
Superscale A Superscale A C 20000000 01.01.2010 Unlimi
Superscale B Superscale B C 20000001 01.01.2010 Unlimi
Superscale C Superscale C C 20000002 01.01.2010 Unlimi i
p 1 1cC 01.01.2010 Unlimi $> £
Kumpulan 2 Kumpulan2 C 20000004 01.01.2010 Unlimi Q== |(0|W|L|S| (== (&
Kumpulan 3 Kumpulan 3 C 20000005 01.01.2010 Unlimi
PGUA PGU4 C 20000006 01.01.2010 Unlimi
(o}

PGU3 PGU3

20000007 01.01.2010 Unlimi

Note: Proficiency scale list of the qualification will be displayed
13. Select a Proficiency.

14. Click on the Tick icon.

> GHOM210 [ & | — 7 X
nihd 4 [ '7 Job: Change Profile (29.05.2022 - 31.12.9999)
~ | B Succession Planning  More &  Exit
* Y A
bl |t B | 20052022 to: 31.12.9999
Find by
> £ Person 2| Job Superscale A
> W User _
5  Applicant = Scale: Performance Appraisal X
Pasition
ob pProficiency
), Search Term E - Tidak Memuaskan
> [ Organizational unit D - Memerlukan Pembaikan
- e B e

> @ Task T - Baik t.. Proficiency Ess Start End Date

equil G oo Bod Yes 29.05.2022 31.12.999¢0
e ves 29.05.2022 31.12.999¢
> | [ = 29.05.2022 31.12.999¢
K e| | [z][=][¥]~
Name Code D
Superscale A Superscale A C 20(
Superscale B Superscale B C 200
Superscale C Superscale C C 20( .
Kumpulan 1 Kumpulan1l C 20( L 1w
Kumpulan 2 Kumpulan 2
Kumpulan 3 Kumpulan 3
PGUA4 PGUA
PGU3 PGU3

B Description 38

Save| Continue
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15. Tick on Checkbox to define the qualification as Mandatory (Optional).

16. Click on the Save button.

= > GHO(M210 (] & —_ &5 X
5 < Job: Change Profile (29.05.2022 - 31.12.9999)
&% Succession Planning  More v/ & Ext
Y A
2 ASRa =) to: 31.12.9999
Find by
, 22 Person 2 Job Superscale A
w
i Start 01.01.2010 - 31.12.9999
> 2% Applicant
& Position
=) Job Requirements
- Search Term
/= Organizational unit
9 Task Qualification group Name St.. Proficiency End Date
Le irements profile (LO) 2 Nationality Bruneian Yes 31.12.999¢C
Hit list F tentang i F tentang i Yes 31.12.999¢
o ==y =NE P Performance Appraisal Performance Result rs ago) A - Cemerlang 31.12.999¢
Name Code D Valid from Valid 1
Superscale A Superscale A C 20000000 01.01.2010 Unlimi
Superscale B Superscale B C 20000001 01.01.2010 Unlimi
Superscale C Superscale C C 20000002 01.01.2010 Unlimi -
1 1cC 01.01.2010 Unlimi <> v
Kumpulan 2 Kumpulan 2 C 20000004 01.01.2010 Unlimi al=liz OlW|T|e|= &
Kumpulan 3 Kumpulan 3 C 20000005 01.01.2010 Unlimi
PGUA4 PGU4 C 20000006 01.01.2010 Unlimi

PGU3 PGU3 C 20000007 01.01.2010 Unlimi

i y S 16

Save| Continue Cancel

Outcome: Job Requirement has been saved.

= > GHAOM210 ] & —_ &5 X
B < Job: Change Profile (29.05.2022 - 31.12.9999)
&' Succession Planning  More Vv &  Exit
» Y A = -
£ | 20.05.2022 to: 31.12.9999
Find by
= Person 2| Job Superscale A
W
Vet Start: 01.01.2010 - 31.12.9999
2% Applicant
S Position
=] Job Requirements
4 Search Term
™ Organizational unit
3 Task Qualification group Name St.. Proficiency Ess Start End Date
€ Reauirements profile (LO) ol Nationality Bruneian Yes v 29.05.2022 31.12.999¢0
Hit list H tentang i ; tentang It Yes v/ 29.05.2022 31.12.999¢
K a = =1y =l = & | Performance Appraisal Performance Result (2 years ago) A - Cemerlang v, 29.05.2022 31.12.999¢
Name Code 0 Valid from Valid 1
Superscale A Superscale A C 20000000 01.01.2010 Untimi
Superscale B Superscale B C 20000001 01.01.2010 Unlimi
Superscale C Superscale C C 20000002 01.01.2010 Untimi gl
P 1 1cC 01.01.2010 Unlim £ (I
Kumpulan 2 Kumpulan 2 C 20000004 01.01.2010 Unlimi Q|| 0|26 |(2]|=] (&|C
3 3cC 01.01.2010 Unlimi
PGUA4 PGU4 C 20000006 01.01.2010 Unlimi
PGU3 PGU3 C 20000007 01.01.2010 Unlimi
Ses [mmien P P
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ASSIGN QUALIFICATION Backend User

TO POSITION

Log into SAP GUI (Back End) and proceed with the following steps.

1. Enter PPPM in the search bar.

b-z- '? 1 SAP Easy Access
H = & & Ohermenu ¥ k S Vv A W Createrole More

» [ Favorites
“ 19 SAP Menu

> GHOM210 (] & | — [ X

Q o G Ex

» [J Connector for Multi-Bank Connectivity

5 [ Office
> [ Cross-Application Components
» [ Logistics

> [7] Accounting

“1Human Resources
[ Information Systems
> [ Service
» [0 Tools
»1[ WebClient Ul Framework

Note: Change Profile Page will be displayed.

> GHo(210 ] & | — F X

< W User: Change Profile (29.05.2022 - 31.12.9999)

B CareerPlanning ¢ CurrentPosition  More

& Ext

i Ead 1 | 20.05.2022 to: 31.12.9999
Find by

> g2 Person

> WJ User

» 22 Applicant

> & Position

& Job

Plan version 'Current plan’ was set

Save Continue Cancel
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2. Click on the dropdown for Position.
3. Click on the Search Term button.
= > GHA(210 (] & - X
< w User: Change Profile (29.05.2022 - 31.12.9999)
~ | & Career Planning & Current Position ~ More & Exit

5 @y

3, Structure search
£l Job
> = Organizational unit
> & Task

Sauel Continue Cancel

Note: A view page of Find Position will be displayed.

4. Enter the With name: field with (*) or a specific name

5. Click on the Tick (Find) icon.

> GHO()210 [ & 5 x

< »3: , User: Change Profile (29.05.2022 - 31.12.9999)

& CareerPlanning & Current Position  More &  Exit

Find Position x £ | 29.05.2022 to: 31.12.9999

I With name: [* |

Assigned

to: ~

Object

d

Save Continue Cancel
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Note: A list of Position will be displayed under Hit list.

6. Double click on a specific Position on the Hit list.

= > GHaM210 [ &/ _— O X
< User: Change Profile (29.05.2022 - 31.12.9999)
~ Zr Career Planning H§ Current Position More ~ = Exit
o ¥|lA 2 | 29.052022 to: 31.12.9999
Find by i
, :.l:::til:ant

©, Search term
2 Structure search
» B Job
> = Organizational unit
- Task . -
Hit list

=) [a] | 5] [E] F]~ 2| [B ]| [=

Icon Existence Name
2 KET.PEMB.TEKNIK
PEMELIHARA KAWASAN

a8 PEMBANTU PEJABAT

N BIGURAN
s PEN.PEG.PERHUBUNGAN AWAM
& PEMBANTU PEJABAT
& PEMELIHARA KAWASAN
a2 PEKERJA TINGKAT V O/V
& PENJUAL TIKET OV

Note: Position Requirement Page will be displayed.

7. Click on the Create icon.

= > GHa()210 [ & - O X
% v < SAF Position: Change Profile (29.05.2022 - 31.12.9999)
& Succession Planning 9 Current Holder  More &  Exit
Y A
2 YA F 29052022 to: 31.12.9999
Find by
> g2 Person z Position: PEMBANTU PEJABAT
>
- User Start: 01.01.1900 - 31.12.9999
> 22 Applicant
+ & Position Holder
7 Search term Org. unit: JABATAN BELIA DAN SUKAN
), Structure search
Requirements
» B Job EEEEEEEEEEE
» = Organizational unit
2 Task _ - Qualification group Name St.. Proficiency Ess Start End Date &
Hit list Nationality Bruneian Yes 01.01.2010 31.12.999¢0
> =1 ==V~ 2 B 2‘ Pengetahuan tentang Pengetahuan tentang Yes 01.01.2010 31.12.999¢

- A v

Icon Existence Name

8 KET PEMB TEKNIK
8 PEMELIHARA KAWASAN

& PEMBANTU PEJABAT

8 PEN KET PEG BISUKAN

a PEN.PEG PERHUBUNGAN AWAM Ly oo
a PEMBANTU PEJABAT AEAIE s |=|=]| 2|2

8 PEMELIHARA KAWASAN

& PEKERJA TINGKAT V OV

8 PENJUAL TIKET OV

Save Continue
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= > GHO(Y210 (B & | — 7 X
e 4 »-E- ‘7 Pasition: Change Profile (29.05.2022 - 31.12.9999)
= q htion (1) x
& Exit
S: Search Term T: Structure Search | C: Abbreviation and NameR: Searc... > ..,
Search Term: || § 20052022 to: 31.12.9999
Find by
> i Pers :JABAT
> 15 Used - 31.12.9999
&2 App| 3o Mul
~ & Posilio
Q, Search term Org. unit: JABATAN BELIA DAN SUKAN
1 Structure search .
Requirements
> B Job ——
» = Organizational unit
s 2 Task - Qualification group Name St.. Proficiency Ess Start End Date &
Hit list Nationality Bruneian Yes 01.01.2010 31.12.999¢0
2l == F~ EINE = Pengetahuan tentang Pengetahuan tentang Yes 01.01.2010 31.12.999¢
lcon Existence Name
8 KET.PEMB.TEKNIK
&8 PEMELIHARA KAWASAN
2 PEMBANTU PEJABAT
A PENKET.PEG.B/SUKAN
a PEN.PEG.PERHUBUNGAN AWAM <> '
& PEMBANTU PEJABAT A iz lis! 10w |2 = | |& O
& PEMELIHARA KAWASAN
2 PEKERJA TINGKAT V OV
) PENJUAL TIKET OV

tinue

Note: Qualification Catalog will be displayed.

9. Click on the dropdown button next to the Folder icon to reveal its contents

10. Click on a qualification to selectit.

Note: More than one qualification can be added at a time.

11. Click on the Tick icon.

Find

b E ation

>® ience Skim Perkhidmata

I

> [ Nationality
O CEP

> E [J CSLP Flagship Program

> . 3
8 >

Hit lis

ool Peperiksaan peraturan Am 1961

. B | Peperiksaan peraturan Kewangan
a periksaan Perkhidmatan Pentadbiran
8 s

8

- [

a >

a >

& » [ Kursus Mandator

a > [ Tempoh Memangku

2

Choose Qualification

QK 50085403
Q 50085486
Q 50085487
Q 50085488

X .31.12.9999)

3 29052022

General

Education

Experience S
Expi
Perfor

Nationality
CEP

CSLP Flagsh

Lan,

ange

CSLP Pool St..

Peper

aan Yes
Peperiksaan 1g kerasmian Yes
Peperiksaan

Peperiksaan

Peperiksaan

Pengetahuan

Bachelor Deg

Proficiency

> GHA()210 [ & | — & X
& Exit
to: 31.12.9999
Ess Start EndDate ©

01.01,2010 31.12.999¢0
01.01.2010 31.12.999¢

Save

Continue

Cancel
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Note: You will be navigated back to the Job Requirement Page with the chosen qualifications.

12. In one of the qualifications, under Proficiencies, click on the Lookup icon.

= > GHA(W210 ] & | _— 5 X
B < W Pasition: Change Profile (29.05.2022 - 31.12.9999)
& Succession Planning ¢ Current Holder  More v &  Exit
> ¥ |A 20052022 to: 31.12.9999

Find by
> & Person . Position: PEMBANTU PEJABAT
» 7 User Start 01.01.1900 - 31.12.9999
> 2 Applicant
~ & Position Holder:

O Search term Org. unit: JABATAN BELIA DAN SUKAN

1 Structure search Requirements

> B Job —_—
» = Organizational unit

2 Task i} o Qualification group Name St.. Proficiency Ess Start End Date &
Hit list Nationality Bruneian Yes 01.01.2010 31.12.999¢0
P A ==V v 2 B v [ Pengetahuan tentang Pengetahuan tentang Yes 12 01.01.2010 31.12.999
Icon Existence Name Pepesssaon Peperiksaan Jabatan F\ H 29.05.2022 31.12.999¢
8 KET.PEMB.TEKNIK
&8 PEMELIHARA KAWASAN
2 PEMBANTU PEJABAT
& PENKET PEG.B/SUKAN
a PEN.PEG.PERHUBUNGAN AWAM < '
a PEMBANTU PEJABAT a|=[e|ale(r]e] 2]+ (=
& PEMELIHARA KAWASAN
8 PEKERJA TINGKAT V O/V
&8 PENJUAL TIKET OV

Note: Proficiency scale list of the qualification will be displayed
13. Select a Proficiency.

14. Click on the Tick icon.

> GHO(D210 [ &/ 5 x

B < y Paosition: Change Profile (29.05.2022 - 31.12.9999)

& Succession Planning & Current Holder ~ More ™ &  Exit

* ¥ A
== 4 20052022 to: 31.12.9999

Find by

> &2 Person - Position: PEMBANTU PEJABAT
> W User
2 Applicant

Start: 01.01.1900 - |31.12.9999

~ & Position Scale: Lulus/Tidak Lulus x
Q Search term
1 Structure search

> E Job
> = Organizational unit
O Task i} St.. Proficiency Ess Start End Date &
Hit list Yes 01.01.2010 31.12.999%¢.
- @, | =¥ v Yes 01.01.2010 31.12.999¢

29.05.2022 31.12.999¢

Icon Existence Name

a KET.PEMB.TEKNIK

a PEMELIHARA KAWASAN

=3 PEMBANTU PEJABAT

a PEN KET.PEG.BISUKAN

a PEN.PEG.PERHUBUNGAN € '
a PEMBANTU PEJABAT

a PEMELIHARA KAWASAN

a PEKERJA TINGKAT V OV

a PENJUAL TIKET OV

Description 32

Save| Continue Cancel
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15. (Optional) Tick on Checkbox to define the qualification as Mandatory.

16. Click on the Save button.

™ < Pasition: Change Profile (29.05.2022 - 31.12.9999)
& Succession Planning ¢ Current Holder  More v
* ¥ |A
Find by
> & Person B Position: PEMBANTU PEJABAT
? i ser Start: 01.01.1900 - 31.12.9999
> @2 Applicant
+ & Position Holder:
7 Search term Org. unit: JABATAN BELIA DAN SUKAN
L Structure search Requirements
» B Job ——
» = Organizational unit
2 Task ° Qualification group Name
Hit list Nationality Bruneian
& 2, ==V~ =] B Pengetahuan tentang Pengetahuan tentang
leon Existence] Name Peperiksaan Peperiksaan Jabatan
8 KET.PEMB.TEKNIK
8 PEMELIHARA KAWASAN
PEMBANTU PEJABAT
& PENKET PEG.B/SUKAN
& PEN.PEG.PERHUBUNGAN AWAM
8 PEMBANTU PEJABAT a, alslzls] [2]=
a PEMELIHARA KAWASAN
8 PEKERJA TINGKAT V OV
&8 PENJUAL TIKET OV

> GHA(N210 [ & | — 5 X
S Exit
[ 20052022 to: 31.12.9999
St.. Proficiency Ess Start End Date &

Yes 31.12.999¢]
Yes 31.12.999
Lulus 31.12.999¢

Outcome: Position

Requirement has been saved.

e 4 »z‘ '? Position: Change Profile (29.05.2022 - 31.12.9999)
~| B Succession Planning & CurrentHolder  More ™
* ¥ A
Find by
> £2 Person - Pasition: PEMBANTU PEJABAT
> 80 User Start: 01.01.1900 - 31.12.9999
> 22 Applicant
& Position Holder:
Q Search term Org. unit: JABATAN BELIA DAN SUKAN
), Structure search T
> B Job ——
> = Organizational unit
> &2 Task . Q ion group Name
Hit list Nationality Bruneian
ol (=] =] v~ 2B ]| (& Pengetahuan tentang P Jan tentang
e BT Peperiksaan Peperiksaan Jabatan
a KET PEMB TEKNIK
a PEMELIHARA KAWASAN
=3 PEMBANTU PEJABAT
a PENKET.PEG.B/SUKAN
a PEN.PEG PERHUBUNGAN AWAM
8 PEMBANTU PEJABAT al=liz [alalzls| =]=] [#] o
a PEMELIHARA KAWASAN
a PEKERJA TINGKAT V OV
a PENJUAL TIKET OV

> GHOm210 B K | — 5
& Exit
E] to: 31.12.9999

St.. Proficiency Ess Start End Date &

Yes v 01.01.2010 31.12.999]

Yes 01.01.2010 31.12.999¢

Lulus v 29.05.2022 31.12.999¢

<> v

X

SSM_UG_SP_Back End (SAP GUI)_JPA_v1.0

54



Sistem Sumber Manusia - Succession Planning '74'

MASS ASSIGN Backend User

QUALIFICATION TO
PERSON

Log into SAP GUI (Back End) and proceed with the following steps.

1. Enter OOQM inthe search bar.

1]
S
D
|
0y
X

h!‘ ’ 1 SAP Easy Access
00QM v|B F & & Othermenu W Rk F 0V A HE createrole  More™ Q & P Exit

> [ Favorites
~ 3 SAP Menu
> [1 Connector for Multi-Bank Connectivity
> [ office
» [ Cross-Application Components
» [ Logistics
> ] Accounting
> [*1Human Resources
> [ Information Systems
> [11 service
> [ Tools
> [1webClient Ul Framework

Note: Qualification Profile: Mass Data Maintenance will be displayed.

= < & _ 37 X
< - : J Qualifications Profile: Mass Data Maintenance
~ | Morev Exit
Profile for z
User w
Selected Object Type @
Object type Name Object ID

<> [N

Qualifications

Name Proficiency Start End Date User Name

<> <>

Plan version 'Current plan’ was set SaveN Refresh Cancel
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2. Navigate to Profile for then choose Person.
= [ - TR 4
< y Qualifications Profile: Mass Data Maintenance

~  More™

Praofile for
IPersan ~ [uL

Selected Object Type &
Object type Name Object ID
< e
Qualifications
Name Proficiency Start End Date User Name @&

<> [N

Save Refresh Cancel

3. Click the textbox beside the Person and press F4 on the keyboard.

< K : 'J Qualifications Profile: Mass Data Maintenance

More ™ Exit

Profile for

Selected Object Type @
Object type Name Obiject ID
<> -
Qualifications
Name Proficiency Start End Date User Name &

Save| Refresh Cancel
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Note: A search engine will be displayed to search for the personnel’s Name,
number.

ID, or IC

Person (1) X > GHQ (1) 200 o 5 X
S: Search Term  T: Structure Search N: Last name - First na... B: PD... ) ... & Mass Data Maintenance
Search Term: m * Exit
@
Object ID
<rv
Start End D&

</ Start Search -+ Multiple Selection  [¥] Close

<y~

Save Refresh Cancel
4. Fill in the Personnel's name and click the Start Search button.
= Person (1) X > GHQ (1) 200 of g x
S: Search Term  T: Structure Search N: Last name - First na... B: PD... > ., & Mass Data Maintenance
Search Term Exit

Object ID

Start End D&

«/ Start Search

s Multiple Selection [¥] Close
o | um | oo
@ 28 | 88

<> v

Save

Refresh  Cancel
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Note: A search engine will be displayed to search for the personnel’s Name, ID, or IC

number.
= Person (1) 6 Entries found x > GHa(1220 g 8 X
S: Search Term T: Structure Search  N: Last name - First na... C: P...  » ..’rofile Matchup
v | (@] [alla][* I Exit
Object abbr. . Object name Start End Datg
29.08.1983 31.03.20.
24.04.2021 31.12.99
06.03.2009 31.12.99
@

02.08.2018 31.12.99
01.01.1985 31.12.99 Object ID
01.01.1985 31.12.99

<> <3
6 Entries found p, —

5. Tick the checkbox beside the desired personnel's name and click the Tick icon to finish.

[y
x

Person (1) 6 Entries found x > GHQ (1) 220 d

S: Search Term  T: Structure Search N: Last name - First na... C: P... > ,..7rofile Matchup

:-| alla] [* IR Exit

Object abbr. . Object name Start End Date

| 29.08.1983 31.03.20
24.04.2021 31.12.99 .

06.03.2009 31.12.99

02.08.2018 31.12.99

01.01.1985 31.12.99 Object ID

01.01.1985 31.12.99

<> <>
6 Entries found 4 _
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Note: The selected name will then be displayed under the Selected Object Type.

Qualifications Profile: Mass Data Maintenance

S isang
Exit

~ | More™
Profile for
r .
Person < u]
L a
Selected Object Type @
Object type Name Object ID
Person 100
3 nl
Qualifications
Proficiency Start End Date User Name

Name

<>
Save) Refresh Cancel

6. In the Qualifications, navigate to row of icons below and click on the Create Icon, as

shown below:

< K :‘ 'J Qualifications Profile: Mass Data Maintenance
Exit

| More™

Person
Selected Object Type &
Object type Name Object 1D
Person 100
<3 <
Qualifications
Proficiency Start End Date User Name

MName

Savel Refresh Cancel
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Note: Qualification will be displayed.

= Qualification (1) X

S: Search Term  T: Structure Search  C: Abbreviationand Na R:S... > ...

Search Term:| (B | *

«/ Start Search J» Multiple Selection [x] Close

7.1. In Qualifications, click Structure Search on the top.

ion (1) X

S: Search Term | T: Structure Search | C: Abbreviationand Na R:S... > ...

Search Term:|[EH| *

«/ Start Search J» Multiple Selection [¥] Close

7.2 Navigate to Government of Brunei Darussalam and select the desired Qualification

in the desired Ministry.

= Choose Qualification X
Name D Code vali...

ﬂ[z‘zovemmen[ Of Brunei Darussatan;] QK 50073001 Government O 01.01
> [0 General QK 50073002 General 01.01.
> [ Ministry Specific Qualification QK 50073003 Ministry Spe 01.01.
> [ Ministry of Religious Affairs QK 50073006 Ministry of 01.01
> [3 Ministry of Energy QK 50073007 Ministry of 01.01.
> [ Ministry of Religious Affairs QK 50073008 Ministry of 01.01.
> [ Ministry of Education QK 50073009 Ministry of 01.01.
> [ Ministry of Development QK 50073010 Ministry of 01.01.
> [ Prime Minister's Office QK 50073011 Prime Minist 01.01
> [3 Ministry of Development QK 50073013 Ministry of 01.01.

(1 Ministry of Education QK 50073015 Ministry of 01.01
> [ Min. of Foreign Affairs QK 50073027 scC 01.01.

[ Min. of Finance & Economy QK 50073028 sD 01.01.

[ Ministry of Culture, Youth and Sports QK 50073033 Ministry of 01.01
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8. Select one or more of the Qualification in one of the ministries and click the Tick icon

once finished.

= Choose Qualification X
Name ID Code Vali...
~ 19 Qualifications catalog (complete)

~ 3 Government Of Brunei Darussalam QK 50073001 Government O 01.01
> [ General QK 50073002 General 01.01
> [J Ministry Specific Qualification QK 50073003 Ministry Spe 01.01
> [0 Ministry of Religious Affairs QK 50073006 Ministry of 01.01
~ U3 Ministry of Energy QK 50073007 Ministry of 01.01

M Geology Q 50073016 Geology 01.01.
8.1 Q 50073021 MMM 01.01.

> [0 Ministry of Religious Affairs QK 50073008 Ministry of 01.01
» [0 Ministry of Education QK 50073009 Ministry of 01.01
> [ Ministry of Development QK 50073010 Ministry of 01.01
> [ Prime Minister's Office QK 50073011 Prime Minist 01.01
» [J Ministry of Development QK 50073013 Ministry of 01.01
[ Ministry of Education QK 50073015 Ministry of 01.01

» [J Min. of Foreign Affairs QK 50073027 sC 01.01.
[ Min. of Finance & Economy QK 50073028 sD 0101
[ Ministry of Culture, Youth and Sports QK 50073033 Ministry of 01.01

Note: The chosen Qualification will then be displayed..

Qualifications

Name Proficiency Start End Date User Name &
Language 23.05.2022 22.05.2023
<2 <>V
Qlils=| alwriel = =2

9. Navigate to the column Proficiency and press F4 on the keyboard or click the icon

beside the column.

Qualifications

Name Proficiency tart End Date User Name &
Language 3.05.2022 22.05.2023
< > <>V
Q|| |djuw L(s||=|=| T
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Note: Scale: Points will then be displayed.

Scale: Points Scale (1-3)

proficiency
sufficient
Good

-

Very Good
C

«f Description %

10. Double-click the Proficiency or click the Proficiency and click the Tick icon.

Scale: Points Scale (1-3)

proficiency

Su e
10.1
4
J

101

«/ Description 8%

Note: The chosen Proficiency will then be displayed.

Qualifications
Name Proficiency Start End Date User Name &

Language

Very Good 23.05.2022 22.05.2023

< >V

< >
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11. Once everything is finished, click the Save button.
«C & A8 x

Qualifications Profile: Mass Data Maintenance

ST

~ | More>
Person
Selected Object Type @
Object type Name Object ID
v Person 100
< <
Qualifications
Name Proficiency Start End Date User Name
~  Teamwork Skilled .05.2022 31.12.9999
3w

Outcome: Mass qualification has been successfully assigned to person.

Save

Refresh

Cancel
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MASS ASSIGN Backend User

QUALIFICATION TO JoB KN

Log into SAP GUI (Back End) and proceed with the following steps.

1. Enter ZHCMSP002_MASS in the search bar.

»-.3! , 1 SAP Easy Access
ZHCMSP002 MASS | B [ & & Othermenu ¥ % 7 Vv A [ Createrole MoreV QA 9 P oExt

» [ Favorites
~ 1 SAP Menu
» [ Connector for Multi-Bank Connectivity
> [1) Office
» [ Cross-Application Components
> [ Logistics
» [ Accounting
> [1) Human Resources
> [ Information Systems
> [ service
> [ Tools
> [*] webClient UI Framework

Note: Mass Upload Assign Qualification will be displayed.

< - : J Mass Upload Assign Qualification

~ @ saveas Variant... More Exit

Mass Upload Assign Qualification
Person (P): @
Position (S)
Job (C)

File:

SSM_UG_SP_Back End (SAP GUI)_JPA_v1.0 64



®
MR,

Sistem Sumber Manusia - Succession Planning ‘74'
2. Choose Job.
= < B _ 5 x
< - : J Mass Upload Assign Qualification
v | @ Save as Variant More v Exit

Mass Upload Assign Qualification

Person (P)

Position (S) 2

Job (C): @
o

File:

3. Click the textbox beside File and press F4 on the keyboard or click the icon beside

the textbox.

Qe

~| @ save as Variant... More

Mass Upload Assign Qualification
Person (P)
Position (S)

=
Job (C): @

Mass Upload Assign Qualification

Exit

File:

SSM_UG_SP_Back End (SAP GUI)_JPA_v1.0
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Note: List of Document will be displayed.

Open X
Look in- Dacuments v| B
:" Name Status Dat.. ~
Quick access
r e E
Mass Assign Qualification to Job-Position-Person v2 g 5/23/2C
Desktop
m
Libraries
This PC
Network .
File name: Mass Assign Qualification to Job-Position-Perso ~~ Open
Files of type: All Files (**) A% Cancel

4. Choose specific file for Job Qualification template and click the Open button.

Open X
Look in: Documents v| BFE]
:" Name Status Dat.. -
Quick access

183 Mass Assign Qualification to Job-Position-Person v2 g5 5/23/24

Desktop

m

Libraries

This PC

Network .
< 4
File name: Mass Assign Qualification to Job-Position-Perso ~/
Files of type: All Files (") v Cancel
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5. Once uploaded, clickthe Execute button.
= < B _ = X
[GES :‘ 'J Mass Upload Assign Qualification

~ @ save as variant... More

Exit
Mass Upload Assign Qualification

Person (P):
Pasition (S):
Job (C): @

ZIC : \Users h\oneDrive - Dynamik Te

Note: Pop Up window for SAP GUI Security will be displayed.

SAP GUI Security

The system Is trying to access the file

C:\Users\

\DOCUMENTS\MASS ASSIGN QUALIFICATION TO JOB-POSITION-PERSON V2.XLSX

Do you want to grant access to this file?

Remember My Decision

Allow Deny

Help

SSM_UG_SP_Back End (SAP GUI)_JPA_v1.0
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6. Click the Allow button.

SAP GUI Security X

The system is trying to access the file

C:\Users\, :
\DOCUMENTS\MASS ASSIGN QUALIFICATION TO JOB-POSITION-PERSON V2.XLSX

Do you want to grant access to this file?

Remember My Decision

Allow Deny Help
Note: List of Qualification and Job will be displayed.
= < & _ 7 x
< b: : J Mass Upload Assign Qualification
v & = F ¥V [x (w 1 @ EXPORT Morev Q @ Exit

Indicator Status Obj. type ID rel.obj Job Desc Object ID Qual Desc Start date End Date Proficien. Msg. Var. Msg. Var. Msg. Var. Msg. Var.
e

4 c 20000000 Superscale A 50085111 CEP 01.01.1900 31.12.9999 3
La
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7. Check the Qualification to Job desired to be assigned.
= < B _ 5 x
< W Mass Upload Assign Qualification
vi@a =2 T ¥V [x (W L1 @@ EXPORT Morev Q @ Exit

Gtatus Obj. type ID rel.obj Job Desc Object ID Qual Desc Start date End Date Proficien. Msg. Var. Msg. Var. Msg. Var. Msg. Var.

Cc 20000000 Superscale A 50085111 CEP 01.01.1900 31.12.9999 3

8. Then click the Export button.

< K : J Mass 8. Assign Qualification
v v [x (w 4 i More v Q = Exit

Proficien. Msg. Var. Msg. Var. Msg. Var. Msg. Var.

Indicator Status Obj. type ID rel.obj Job Desc Object ID Qual Desc Start date End Date

ra
o Cc 20000000 Superscale A 50085111 CEP 01.01.1900 31.12.9999 3
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Outcome: Mass qualification has been successfully assigned to Job.

= < B -8 x
< w Mass Upload Assign Qualification
via &2 F ¥V fx (w L @& EXPORT Morev Q @ Exit
Indicaf Status Obj. type 1D rel.obj Job Desc Object ID Qual Des_Start date End Date Proficien. Msg. Var. Msg. Var. Msg. Var. Msg. Var.
EJ: W s ccess c 200000 Superscale A 500851 CEP 01.01.1900  31.12.9999 3
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MASS ASSIGN Backend User

QUALIFICATION TO
POSITION

Log into SAP GUI (Back End) and proceed with the following steps.

1. Enter ZHCMSP002_MASS in the search bar.

h!‘ ’ 1 SAP Easy Access
ZHCMSP002_MASS B F & & othermenu ¥ Kk v A ® Create role  More™

> [ Favorites
~ T3 SAP Menu
» [ Connector for Multi-Bank Connectivity
» [ office
» [ Cross-Application Components
» [ Logistics
> [ Accounting
> [) Human Resources
» 71 Information Systems
> [ service
> [ Tools
> (1] WebClient Ul Framework

Note: Mass Upload Assign Qualification will be displayed.

< - : J Mass Upload Assign Qualification

~ @ saveas Variant... More

Exit

Mass Upload Assign Qualification
Person (P): @
Position (S)
Job (C)

File:

71
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2. Choose Position.
= < B _ 5 x
< - : J Mass Upload Assign Qualification
~ | [@ Save as Variant More v Exit

Mass Upload Assign Qualification

Person (PN

3. Click the textbox beside File and press F4 on the keyboard or click the icon beside

the textbox.

Qe

~| @ save as Variant... More

Mass Upload Assign Qualification

Mass Upload Assign Qualification

Exit

Person (P)
r A
Position (5): @
5 £
Job (C)
File:

SSM_UG_SP_Back End (SAP GUI)_JPA_v1.0
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Note: List of Document will be displayed.

Open X
Lookin' | = Documents v | B
:I Name Status Dat..
Quick access
- Mass Assign Qualification to Job-Position-Person v1 g5 5/23/2C
Desktop
m
Libraries
This PC
Network =
File name: Mass Assign Qualification to Job-Position-Perso ~/ Open
Files of type: All Files (") v Cancel

4. Choose specific file for Position Qualification template and click the Open button.

Open X
Lookin- | 2 Documents v| G
:" Name Status Dat.. -
Quick access
- B3 Mass Assign Qualification to Job-Position-Person v1 = 5/23/2(]
Desktop
m
Libraries
This PC
Network .
< 4
File name: Mass Assign Qualification to Job-Position-Perso ~/
Files of type: All Files (") v Cancel
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5. Once uploaded, clickthe Execute button.

¢ B -8 %
JET

Mass Upload Assign Qualification

~ [@ save as Variant More v

Exit
Mass Upload Assign Qualification

Person (P):
Position (S): @

Job (C).
-

o
Z3MlAss1gn Qualification to Job-Position-Person vl.xlsx] JJ‘
L

I |

Note: Pop Up window for SAP GUI Security will be displayed.

SAP GUI Security

The system Is trying to access the file

C:\Users\
\DOCUMENTS\MASS ASSIGN QUALIFICATION TQ JOB-POSITION-PERSON V1.XLSX

Do you want to grant access to this file?

Remember My Decision

Allow Deny Help

SSM_UG_SP_Back End (SAP GUI)_JPA_v1.0 74



Sistem Sumber Manusia - Succession Planning

6. Click the Allow button.

SAP GUI Security X

The system is trying to access the file

C:\Users\, )
\DOCUMENTS\MASS ASSIGN QUALIFICATION TO JOB-POSITION-PERSON V1.XLSX

Do you want to grant access to this file?

Remember My Decision

Allow Deny Help
Note: List of Qualification and Position will be displayed.
= <& 8
< b: : J Mass Upload Assign Qualification
v = FT ¥V [x (w 1 # EXPORT Morev Q @ Exit

Indicator Status Obj. type ID rel.obj Pos Desc Object ID Qual Desc Start date End Date Proficien. Msg. Var. Msg. Var. Msg. Var. Msg. Var.
e

4 s 30031678 KERANI 50085135 Bruneian 01.01.1900 31.12.9999 3
La
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7. Check the Qualification to Position desired to be assigned.
= (B 8 x
< - : J Mass Upload Assign Qualification
v = FT ¥V [x (w 1 # EXPORT Morev Q @ Exit

Btatus Obj. type ID rel.obj Pos Desc Object ID Qual Desc Start date End Date Proficien. Msg. Var. Msg. Var. Msg. Var. Msg. Var.

S 30031678 KERANI 50085135 Bruneian 01.01.1900 31.12.9999 3

8. Then click the Export button.

< K : J Mass 8. Assign Qualification
v v (x (w 4 i More v Q = Exit

Proficien. Msg. Var. Msg. Var. Msg. Var. Msg. Var.

Indicator Status Obj. type ID rel.obj Pos Desc Object ID Qual Desc Start date End Date
ra
L\/J S 30031678 KERANI 50085135 Bruneian 01.01.1900 31.12.9999 3
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Outcome: Mass qualification has been successfully assigned to Position.
= ¢ B _ 8 x
< '-i: ’ Mass Upload Assign Qualification
Q = T ¥V (x fw L & EXPORT Morev Q
Indicaf Status Obj. type ID rel.obj Pos Desc Object ID Qual Des_Start date End Date Proficien. Msg. Var. Msg. Var. Msg. Var. Msg. Var.
:-/j B g ccess S 300316 KERANI 500851 Bruneian 01.01.1900 31.12.9999 3

Exit
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MASS ASSIGN Backend User

QUALIFICATION TO
PERSON

Log into SAP GUI (Back End) and proceed with the following steps.

1. Enter ZHCMSPO002 MASS in the search bar.

1l
En
I
oy
X

»-.3! , 1 SAP Easy Access
ZHCMSP002 MASS | ® [ & & Othermenu ¥ % F Vv A [ Createrole MoreV QA 9 P oExt

» [ Favorites
~ T3 SAP Menu
» [ Connector for Multi-Bank Connectivity
» [ office
» [ Cross-Application Components
» [ Logistics
> 1] Accounting
> [ Human Resources
> [ Information Systems
> [ service
> [ Tools
> (1] WebClient Ul Framework

Note: Mass Upload Assign Qualification will be displayed.

I
D
|
0y
X

< - : J Mass Upload Assign Qualification

~ @ saveas Variant... More Exit

Mass Upload Assign Qualification
Person (P): @
Position (S)
Job (C)

File:
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2. Choose Person.
= <& -8 x
< - : J Mass Upload Assign Qualification
v | [@ save as Variant... More™ Exit
Mass Upload Assign Qualification 2

3. Click the textbox beside File and press F4 on the keyboard or click the icon beside

the textbox.

1]
S
o
|
0y
X

< - : J Mass Upload Assign Qualification
v | [@ save as Variant... More™ Exit
Mass Upload Assign Qualification

Person (P): @

Position (S)

Job (C)
File: I
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Note: List of Document will be displayed.

Open X
Lookin | £ Documents v| BE=
y Name Date modified .
Quick access i ! r— e

Mass Assign Qualification to Job-Position-Person v0  5/23/2022 10:53 AM

Desktop

m

Libraries

This PC

Network -
File name: Mass Assign Qualification to Job-Position-Perso ~/ Open
Files of type: All Files (") v Cancel

4. Choose specific file for Person Qualification template and clickthe Open button.

Open X
Lookin: | =k Documents v| BE
' Name Date modified :
Quick access E

|13 Mass Assign Qualification to Job-Position-Person v0__5/23/2022 10:53 AM_|

Desktop

m

Libraries

This PC

Network =
< 4
File name: Mass Assign Qualification to Job-Position-Perso ~/
Files of type: All Files (") v Cancel
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5. Once uploaded, clickthe Execute button.

< B -8 %
JET

Mass Upload Assign Qualification

~

B save as Variant...  More™

Exit
Mass Upload Assign Qualification

Person (P): @
Position (S):

Job (C)

FGMlAss1gn Qualification to Job-Position-Person vO.x1sxisl
L 4

|

Note: Pop Up window for SAP GUI Security will be displayed.
6. Click the Allow button.

SAP GUI Security

The system is trying to access the file
C:\Users\, :
\DOCUMENTS\MASS ASSIGN QUALIFICATION TO JOB-POSITION-PERSON V0.XLSX

Do you want to grant access to this file?

Remember My Decision

Allow | Deny

Help
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Note: List of Qualification and Person will be displayed.
< b!‘ ? Mass Upload Assign Qualification
v @ = = YV (x (w B # EXPORT Morev Q @ Exit
Indicator Status Obj. type ID rel.obj Full Name Obje.. Qual Desc Start date End Date Proficien. Msg. Var. Msg. Var. Msg. Var. Msg. Var.
v = 100 I 7500. 01.01.1900 31.12.9999 1
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7. Select the Qualification desired to be assigned.
4 r-i* ’ Mass Upload Assign Qualification
v @ = = YV (x fw B # EXPORT Morev Q 5 Ext
Indicator Status Obj. type ID rel.obj Full Name Obje  Qual Desc Start date End Date Proficien. Msg. Var. Msg. Var. Msg. Var. Msg. Var.
P 100 ( 1500 01.01.1900 31.12.9999 1

8. Then click on the Export button.

< F: : :‘ J Mass Upload Assign Qualification
v a = = ¥V o(x f(w B @& More Q & Exit
8
Indicator Status Obj. type ID rel.obj Full Name Obje . Qual Desc Start date End Date Proficien. Msg. Var. Msg. Var. Msg. Var. Msg. Var.
| = “ ) |
v P 100 500 01.01.1900 31.12.9999 1
o 3
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)

Sp)
|
[l

Outcome: Mass qualification has been successfully assigned to Person

Mass Upload Assign Qualification
o B Ext

1§ sang

EXPORT Mare

=]
|
i

v o x
End Date Proficien. Msg. Var. Msg. Var. Msg. Var. Msg. Var.

31.12.9999

- Q
Object ID Qual Des Start date
1

Obj. type 1D rel.obj Full Name
500851 Bruneian 01.01.1900

Indica) Status
il m
v Success P 100
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ASSIGN QUALIFICATION Backend User

TO PERSON Department HR Development

Log into SAP GUI (Back End) and proceed with the following steps.

1. Enter PA30 in the search bar.

> GHoMmz210 [ § — F X

SAP Easy Access

H = & SOhermenu % #% # Vv A [ Createrole More™

» [ Connector for Multi-Bank Connectivity
> [ Office

[ Cross-Application Components

[ Logistics

[ Accounting

["1 Human Resources

[ Information Systems

[ Service

[1 Tools
» [ WebClient Ul Framework

Note: Maintain HR Master Data Page will be displayed.

> GHaMmz210 (] & - X

< W Maintain HR Master Data

/ & O O W @ Morev

Personnel no

Find by
=2 Person
A Collective Search Help
A Search Term
A Free search
Basic personal data

Infotype Text S.. Period
Actions > @ Period
Organizational assignment o
Personal data

Addresses Today
Planned Working Time All
Basic Pay Fron
Bank Details o

Recurring Payments/Deductions
Additional Payments/Deductions
Monitoring of Tasks

Family Member/Dependents
Education

Current Period

=] Choose

Direct selection
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2. Enter Personnel Number and press Enter on the keyboard.
Note: The Personnel’s details will be displayed.
= > GHOWz210 ] & —_ O X
- < Maintain HR Master Data
v 0 /2 & @ 0 W @ Morev Exit
¥ |A Personnel no.:. q z
Find by Heme
+ & Person EE group: 1 Permanent Pers.area: |SA Prime Minister's Office
4 Collective Search Help EE subgroup: 04 Division IV Cost Center
3 Search Term

O, Free search R
Basic personal data

Infotype Text S.. Period
Actions. v | I @ Period
Organizational assignment v From: To:
Personal data v
Today
Addresses v
Planned Working Time v All
Basic Pay v From curr.date
Bank Details 4 To Current Date Last month
Recurring Payments/Deductions v
. ) Current Period Current Year
Additional Payments/Deductions v
Monitoring of Tasks v ] Choose
Family Member/Dependents v
Education vl
Direct selection
Infotype: STy .

3. In the Direct Selection section, Enter Infotype ‘24’ in the Infotype field and press Enter on the

keyboard.

> GHOM210 (] & g5 x

= | < ,_:z: -7 Maintain HR Master Data

1 7 & @ 0 W & Morev Exit

Pers.area: SA Prime Minister's Of

3 Cast Center:

Find by

~ 22 Person
4 Collective Search Help Basic personal data
, Search Term

4 Free search
: Infotype Text Period

Actions.
Organizational assignment

~ (@ Period

From: o0:
Personal data
Today Currweek
Addresses

Planned Working Time All Current month
Basic Pay

Bank Details

From currdate Last week
To Current Date Last month
Recurring Payments/Deductions
Additional Payments/Deductions
Monitoring of Tasks

Family Member/Dependents
Education

Current Period Current Year

=] Choose

&QK&&’\Q\&QR’\?"

Direct selection

I Infotype: 24 STy
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Note: ‘Infotype:’ field will be filled with ‘Qualifications’.

4. Click on the Change icon.

> GHOM210 (] & g5 x

4 Maintain HR Master Data

v alelea 8 0 W @ Morev Exit

¥ A EEgroup: 1  Permanent Persarea: SA  Prime Minister’s Office ~

) EE subgroup: 04 Division IV Cost Center:

Find by

~ 25 Person
, Collective Search Help Basic personal data
), Search Term D

 Free search
: Infotype Text Period

Actions l @ Period

Organizational assignment From: 0
Personal data
Today
Addresses

Planned Working Time Al

Basic Pay From ¢
Bank Details

Recurring Payments/Deductions
Additional Payments/Deductions
Monitoring of Tasks

ToC t Date 5t month
Current Period Current Year
5] Choose

Family Member/Dependents

S..
v
v
v
v
v
v
v
v
v
v
v
v

Education

Direct selection

Infotype] Qualifications STy

Note: Person: Change Profile Page will be displayed.

5. Click on the Create icon.

> GHQ@M210 (] & 5 X
L OAF Person: Change Profile (01.01.1800 - 31.12.9999)
2 Career Planning % Current Position  More v & Exit

Personnel No Name:

Prime Minister's Office

Qualifications Potentials Preferences Dislikes Appraisals Where A A i Where Appi Individual development >

Qualification group Name Proficiency Start End Date Note User Name Changed
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Note: Search Window will be displayed.
6. Click on T: Structure Search.

= > GHOM=z210 ] & _ 5 %
= Person: Change Profile (01.01.1800 - 31.12.9999)

pI

search Term: & [

Appraisals Where Appraiser Individual development ? .
Qualification group Name Proficiency Start End Date Note User Name Changed @
» <5

[
(6
i

i

iSave Continue

Note: Qualification Catalog will be displayed.
7. Click on the Dropdown button to display more qualification options.

8. Click on the Checkbox to select the qualification.
Note: More than one gualification can be added at a time.

9. Click on the Continue button.

> GHO(210 M & | - & X

Choose Qualification x - 31.12.9999)

D Code

atalog (complete) z

runei Darussalam

Education

hidmatan Experience S

¢ er Individual development >
i Performance Result (1 years ago) Q 50085483 Performance
Performance Result (2 years ago) Q 50085484 Performance
Note User Name Changed ©
Performance Result (3 years ago) Q 50085485 Performance e
« Ty Tanonality QK 50085108 Nationality v
3 v Bruneian Q 50085135 Bruneian
> [ CEP QK 50085109
>
>
5 5
> Pej
~ Pe wan
Pengetahuan
Bachelor Deg -
<>

sijil

Ke

> [ Kertas Kerja s Kerja

> [ Kursus Mandatori Kursus Mand: >

Save ntinue
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Note: You will be navigated back to the Change Profile Page with the chosen qualifications.

10. On the qualifications, under Proficiencies, click on the Lookup icon.

GHa (1210 [ & 5 X
< y Person: Change Profile (01.01.1800 - 31.12.9999)

2 Career Planning % Current Posiion  More v/ & Exit

Pri nister's Offi
Qualifications Potentials Preferences Dislikes Appraisals Where Appraisee Appraisals Where Appraiser Individual development >
Qualification group Name Proficiency Start End Date Note User Name Changed
Nationality Bruneian Yes 10 1.1900 31.12.9999 29.05.. °
P tentang i F tentang I Yes .1900 31.12.9999 | 29.05.
Performance Appraisal Performance Result (3 years ago) l\ !l L1900 31.12.9999 29.05.

Savel Continue Cancel

Note: Proficiency list of the specific Qualification will be displayed
11. Select a Proficiency.

12. Click on the Tick icon.

> GHOM210 (] § | — F X
= ~ < "'E: 'J Person: Change Profile (01.01.1800 - 31.12.9999)
Zr Career Planning & Current Posiion  More ™ &  Exi
Personnel No:
= Scale: Performance Appraisal X
EE group: 1  Permanent
EE subgroup: 04 Division IV Broficiency
E - Tidak Memuaskan
Qualfications ~ Potentials ~ F D - Memerlukan Pembaikan nt >
C - Baik
11
Qualification group Changed @
Nationality 29.05..
Pengetahuan tentang kerasmian 29.05.
Performance Appraisal 29.05.

Save Continue  Cancel
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13. Click on the Save button.

= > GHaW210 B] §  — F X
< *: : J Person: Change Profile (01.01.1800 - 31.12.9999)
& Career Planning & Current Position  More v & Exit
Name
EEgroup: 1 Permanent SA  Prime Minister's Office

EE subgroup: 04 | Division IV
Qualifications Potentials Preferences Dislikes Appraisals Where Appraisee Appraisals Where Appraiser Individual development >

Qualification group Name Proficiency Start End Date Note User Name Changed

Nationality Bruneian Yes 01.01.1900 31.12.9999 29.05.

tentang i F tentang I Yes 01.01.1900 31.12.9999 % 29.05.
r o
Performance Appraisal Performance Result (3 years ago) LWt:emerl.ang 0 .01.1900 31.12.9999 29.05.
I <>
A=) (A28 ==
= > GHaM210 B § —_ & X
o OAP Person: Change Profile (01.01,1800 - 31.12.9999)
2 Career Planning 3¢ Current Position  More v & Exit
Personnel No: Name:
EEgroup: 1 Permanent Persarea: SA  Prime Minister's Office
bgroup: 04 Division IV CostC

Qualifications Potentials Preferences Dislikes Appraisals Where Appraisee Appraisals Where Appraiser Individual development >
Qualification group Name Proficiency Start End Date Note User Name Changed
Nationality Bruneian Yes 01.01.1900 31.12.9999 29.05.

tentang i E tentang. I Yes 01.01.1900 31.12.9999 29.05.
Performance Appraisal Performance Result (3 years ago) A - Cemerlang 01.01.1900 31.12.9999 < 29.05.
< v
=) (AlE|2]s] |2]=E
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VIEW QUALIFICATION Backend User

CATALOG Department HR Development

Log into SAP GUI (Back End) and proceed with the following steps.

1. Enter PPQD in the search bar.

> GHoMmz210 [ § — F X

SAP Easy Access

B @ L 2 Ohermenu ¥ Kk F V¥ A B Createrole More v Q o @ Exit

nuj
ector for Multi-Bank Connectivity
» [ Office
» [ Cross-Application Components
[ Logistics
[ Accounting
["1 Human Resources

[ Information Systems
[ Service
[ Tools
» [ WebClient Ul Framework

Outcome: Catalog: Display Qualification(s) will be displayed. Users may click on the

dropdown icon beside the qualification group to view the qualifications.
= < B -0 X
< ’-: : ? Catalog: Display Qualification(s)

Q ¥ A = Posiion o= Segment ® Morew X FindNext &  Exit

Catalog [M 01.01.1900 - 31.,12.9999 01 Current plan
& (1 Government Of Brunei Darussalam

0 [ General
a (] Ministry Specific Qualification
{1 0 Level Subjects
{1 Pejabat Suruhanjaya Perkhidmatan Awam
a (] skim Perkhidmatan Requirement
0 [] UAT Testing Data
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Backend User
JPA and SPA

CREATE CAREER PATH

Log into SAP GUI (Back End) and proceed with the following steps.

1. Enter OOQ4 in the search bar.

h!‘ ’ SAP Easy Access
1
= -
0004 v @ = & & Othermenu W W A v A B Createrole  More™” Q d @ Exit

» [ Favorites
~ T3 SAP Menu
» [ Connector for Multi-Bank Connectivity
» [ office
» [ Cross-Application Components
» [ Logistics
> [ Accounting
> [[] Human Resources
» 71 Information Systems
> [ service
> [ Tools
> (1] WebClient Ul Framework

Note: Career Maintenance page will be displayed.

< w Career Maintenance

~ (@ save as Variant More Exit

[
Plan Version: |01
[

Key Date: 30.05.2022

Plan version 'Current plan’ was set
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2. Fill' in the Plan Version.
= < B _ 5 x
< - : J Career Maintenance
v | [@ save as Variant... More ™ Exit
2

[ e T
Plan Version: |01
[

Key Date: 30.05.2022

Plan version 'Current plan’ was set

3. Fill in the date of desired Career Path to be created.

< - : J Career Maintenance

~| @ save as Variant... More

Exit

—
Plan Version: |01

Key Date:  30.05.2022

Plan version ‘Cument plan’ was set
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4. Then click the Execute button.
= < B _ 5 x
< - : J Career Maintenance
ol [E'] Save as Variant... More v Exit

—
Plan Version: |01
[

Key Date: 30.05.2022

Plan version 'Current plan’ was set

5. Click the Create Icon.

= < B _ 5 x
< K : 'J Career Maintenance
5
~ - T T 2 3 @ (x v L B B B B YV Q Morev Q &  Exit

Career
Plan Version: 01 Current plan
Date 30.05.2022
Object ID Object name Name

&

Y

a

&

o
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2 =
Sumpen ™
6. Enter a name for the Career Path.
= cCareer Edit Goto List Settings System Help > GHQ (1) 200 & 8 x
Ei: ’ Career Maintenance
vifl] £ 6 & = = ¥ B x (w B ® & B 8 Y Q Morev Q @& Exit
Career ~
v
= Create Career X
Name of career:
I Career Path Salary Scale Umum
a0 =X

7. Click the name of the Career Path.

= < B 8 X
< I-E . 7 Career Maintenance
v Z2 & &4 T =2 @ B8 [x v L B B B B VY @Q Mrev Q @ Exit
Career -
Plan Version: 01 Current plan =
Object ID Object name Name

I 50085585 Career Path Salary Scale Umum |
B i
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8. Click the Edit Icon.

0 sapg '

Career Maintenance

MY x v L B8 B B Y @ Mrev

Career

Plan Version: 01 Current plan

Object ID Object name

r a
50085585 Career Path Salary Scale Umum
L 4

o

Note: Edit Career Path will be displayed.

Edit Career Items

Career Edit Goto View Settings Help
(] C@@ D6
®) 8 qEEE

Display Area

CareerPath Salary
Scale Umum

Legend

s

Fosmen

___|.

30.05.2022

[“Node Area

_A

v

>
@E RiaEY
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9. Click the Job Icon.

Edit Career Items

Career Edit Goto View Settings Help

@ S B|H/H
& QH B T 6 s

Display Area
CareerPath salary
Scale Umum
Legend
Camer se sewsen
30.05.2022 |

Navigation Area
Career Path Salary
Scale Umum

A

v

10. Then add the Blue Icon into the structure.

>
@ﬁ RiamY

Edit Career Items

Career Edit Goto View Settings Help

(] C@@ D6
® e HBE I EE

isplay Area
CareerPath Salary
Scale Umum
Legend
cane s sesnen
30.05.2022 |

Navigation Area
Career Path Salary
Scale Umum

>
@E RiaEY
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11. Fill in the Job name or Search with * then Click the Tick Icon.

S: Search Term

Restrict Value Range

C: Abbreviation and Name

Search Term:

R: Search Term with Restrict... > ...

Note: The new Job has been added

Edit Career Items

| Display Area

Career Edit Goto View Settings Help

1] Clo@ SR a
UV 1 =5 =

Career Path Salary
Scale Umum

Camer

Legend

oo

_____ |

30.05.2022 |

<

["Node Area

<

-
_

v

‘New career tem defined

>
@W RIZEP

Note: Repeat the steps from Step 8-11 by dragging the Job Icon following structure of

Career Path.

SSM_UG_SP_Back End (SAP GUI)_JPA_v1.0

98



®
MR,

Sistem Sumber Manusia - Succession Planning B

Note: To delete the Job Icon, Click the Job Icon and Click the Delete Icon.
Edit Career ltems - O X
Career Edit Goto View Settings Help
T Note PRI
ST [ 5
Display Area
Career Path Salary -
Scale Umum
Legend
30.05.2022 |

New career item defined

12. Once the structure is done, Click the Save Icon.

Edit Career Items - O X
b 12 Goto View Settings Help
¢l |cae cmm
&|& 0 |BE| £
Display Area Navigation Area
Career Path Salary ~ | fCereer Path Salary
Scale Umum
Legend
. s -
30.05.2022 |
[~Node Area
_ :
v v
< > < >
New career tem defined FHO |§ Rizmp
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13. Then Click the Close Icon to close the Career Path Structure.

Edit Career Items - O X
Career 13 View Settings Help
¢ O gop =
& & i =5 =
| Display Area
Career Path Salary -
Scale Umum
Legend
Caver Joo Pogimon
30.05.2022 |
[~Node Area
~
_
v v
< > < >
New career tem defined fHa 75 Ry
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Backend User
EDIT CAREER PATH

JPA and SPA

Log into SAP GUI (Back End) and proceed with the following steps.

1. Enter OOQ4 in the search bar.

w 1 SAP Easy Access

r —
0004 ~(|®B @@= & & Othermenu W W A v A E Create role  More™” Q o P Exit

> [ Favorites
13 SAP Menu
» [1] Connector for Multi-Bank Connectivity
> [1) Office
» [ Cross-Application Components
> [ Logistics
» [ Accounting
> [[] Human Resources
» [*] Information Systems
> [ service
> [ Tools
> (1] WebClient Ul Framework

Note: Career Maintenance page will be displayed.

< & — 8 X
< w Career Maintenance

~ (@ save as Variant More Exit

[
Plan Version: |01 |(J
[

Key Date: 30.05.2022

Plan version 'Current plan’ was set
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2. Fill' in the Plan Version.
= < B _ 5 x
< - : J Career Maintenance
v | [@ save as Variant... More ™ Exit
2

[ e T
Plan Version: |01
[

Key Date: 30.05.2022

Plan version 'Current plan’ was set

3. Fill in the date of desired Career Path to be created.

< - : J Career Maintenance

~| @ save as Variant... More

Exit

—
Plan Version: |01

Key Date:  30.05.2022

Plan version ‘Cument plan’ was set
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4. Then click the Execute button.
= < & _ 7 x
< w Career Maintenance
ol [E] Save as Variant... More v Exit

—
Plan Version: |01 |(
[

Key Date: 30.05.2022

Plan version 'Current plan’ was set

5. Click the name of the Career Path.

L4 W Career Maintenance

vl 2 &8 A& T 2 3 @ & (v L B 8 B B YV @ Morv Q @

Career =

Plan Version: 01 Current plan

Object ID Object name Name

'

EH

ol

sooassal?:areer Path Salary Scale Umum |
N ",
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6. Click the Edit Icon.

0 sapg -

Career Maintenance

MY x v L B8 B B Y @ Mrev

Career

Plan Version: 01 Current plan

Object ID Object name

r a
50085585 Career Path Salary Scale Umum
L 4

o

Note: Edit Career Path will be displayed.

Edit Career Items

Career Edit Goto View Settings Help
(] C@@ D6
®) 8 qEEE

Display Area

CareerPath Salary
Scale Umum

Legend

s

Fosmen

___|.

30.05.2022

[“Node Area

_A

v

>
@E RiaEY
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7. Click the Create Icon.
Edit Career Items O X

Career Edit Goto View Settings Help

@ S B|H/H
& QH B T 6 s

Navigation Area
Career Path Salary
Scale Umum

Display Area
CareerPath salary
Scale Umum
Legend
Camer se sewsen
30.05.2022 |

8. Then add the Blue Icon into the structure.

Edit Career Items

Career Edit Goto View Settings Help

(] C@@ D6
® e HBE I EE

isplay Area
CareerPath Salary
Scale Umum
Legend
cane s sesnen
30.05.2022 |

>
@E RiaEY
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2 S
v, &
Unpen ™

9. Fill in the Job name or Search with * then Click the Tick Icon.

= & > GHQ (1) 200 o 5 X
< Co
[ cae SN a Exit
&|a/[E TEE

= Restrict Value Range X

S: Search Term C: Abbreviation and Name R: Searfh Term with Restrict... >

Search Term: *

08.07.2022

< > < >
GHG 754 REP

Note: The new Job has been added

Edit Career Items — O X
Career Edit Goto View Settings Help
1] Ca@ 2/ @
&8 B8 £
Display Area
Career Path Salary ~
Scale Umum
Legend
Comer I sewsen
30.05.2022 |
v
< > < >
‘New career item defined @ E El |8

Note: Repeat the steps from Step 8-11 by dragging the Job Icon following structure of

Career Path.
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Note: To delete the Job Icon, Click the Job Icon and Click the Delete Icon.
Edit Career ltems - O X
Career Edit Goto View Settings Help
R Note | PRI
ST [ E
Display Area
Career Path Salary -
Scale Umum
Legend
30.05.2022 |

New career item defined

10. Once the structure is done, Click the Save Icon.

Edit Career Items - O X
b 10 Goto View Settings Help
¢l |cae cmm
&|& 0 |BE| £
Display Area Navigation Area
Career Path Salary ~ | fCereer Path Salary
Scale Umum
Legend
. s -
30.05.2022 |
[~Node Area
_ :
v v
< > < >
New career tem defined FHO |§ Rizmp
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11. Then Click the Close Icon to close the Career Path Structure.

Edit Career Items - O X
Career 11 View Settings Help
¢ O gop =
& & i =5 =
| Display Area
Career Path Salary -
Scale Umum
Legend
Caver Joo Pogimon
30.05.2022 |
[~Node Area
~
_
v v
< > < >
New career tem defined fHa 75 Ry
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Backend User
JPA and SPA

RENAME CAREER PATH

Log into SAP GUI (Back End) and proceed with the following steps.

1. Enter OOQ4 in the search bar.

= < & _ @O %
h!‘ ’ SAP Easy Access
1
H = & & otermenu W W A v A B Createrole  More™” Q d @ Exit

» [ Favorites
~ T3 SAP Menu
» [ Connector for Multi-Bank Connectivity
» [ office
» [ Cross-Application Components
» [ Logistics
> [ Accounting
> [[] Human Resources
» 71 Information Systems
> [ service
> [ Tools
> (1] WebClient Ul Framework

Note: Career Maintenance page will be displayed.

< B & X

< w Career Maintenance

~ (@ save as Variant More Exit

[
Plan Version: |01 |(J
[

Key Date: 30.05.2022

Plan version 'Current plan’ was set
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2. Fill' in the Plan Version.
= < B _ 5 x
< - : J Career Maintenance
v | [@ save as Variant... More ™ Exit
2

[ e T
Plan Version: |01
[

Key Date: 30.05.2022

Plan version 'Current plan’ was set

3. Fill in the date of desired Career Path to be created.

< - : J Career Maintenance

~| @ save as Variant... More

Exit

—
Plan Version: |01

Key Date:  30.05.2022

Plan version ‘Cument plan’ was set
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4. Then click the Execute button.
= < & _ 7 x
< w Career Maintenance
ol [E] Save as Variant... More v Exit

—
Plan Version: |01 |(
[

Key Date: 30.05.2022

Plan version 'Current plan’ was set

5. Click the name of the Career Path.

L4 W Career Maintenance

vl 2 &8 A& T 2 3 @ & (v L B 8 B B YV @ Morv Q @

Career =

Plan Version: 01 Current plan

Object ID Object name Name

'

EH

ol

sooassal?:areer Path Salary Scale Umum |
N ",
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6. Click the Rename Icon.
= < & _ 7 x
< LA Career Maintenance
SAP4 5
vif] # & T 2 3 B8 x v 4 B B B B YV Q Morev Q @ Exit
Career -
Plan Version: 01 Current plan =
Object ID Object name Name
&
=
i
&
i
2

.

r a
50085585 Career Path Salary Scale Umum
L 4

7. Rename the Career Path and Click the Rename Icon.

= career Edit Goto List Settings System Help > GHQ (1) 200 & _ 7 X
< E : J Career Maintenance
v ] A = = 3 9 fx v B =® g B B YV @ More v Q &  Exit

Career o
v

Plan Version: 01 Current plan

Object ID Object name Name

L . Dath Calan: Canln Limim

= Rename Career X

Name of career:
I Career Path SS Umum
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Outcome: Career Path name has been successfully renamed.

< - : J Career Maintenance

v #Z 6 &4 T = @A @ x v L B 8 B B Y Q Morv

Career

Plan Version: 01 Current plan

Object ID Object name Name
[ ]
SOOBEEBEJCareer Path SS Umum

el e

Hil
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GENERATE PROFILE Backend User

MATCHUP REPORT JPA, SPA and Department HR Development

Log into SAP GUI (Back End) and proceed with the following steps.

1. Enter PEPM in the search bar.

= < & _ @O %
h!‘ ’ 1 SAP Easy Access
= F & & Othermenu ¥ & 7 v A B Createrole  More™” Q o @2 Exit

> [ Favorites
13 SAP Menu
» [ Connector for Multi-Bank Connectivity
> [1) Office
» [ Cross-Application Components
> [ Logistics
» [ Accounting
> [[) Human Resources
» [*] Information Systems
» [ service
> [ Tools
> [*] webClient UI Framework

Note: Display Profile Matchup will be displayed.

= < & _ B8 X
< E : 'J Display Profile Matchup
(C More v Exit
Profile Matchup
User v Position ~
Qualifications profile of @ Reguirements profile of @
Type Name Type Name Object ID

[ [ <> [

Editing Options
Generate Training Proposals

Qualification Deficits Only

* Key date: | 19.05.2022
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Note: Navigate to Profile Matchup.
2. Select the option Person from the dropdown.
3. Click on the Lookup icon to select Personnel(s).
< ¥ :‘ 'J Display Profile Matchup
Profile Matchup )
IFerson—q Position ~
Qualifications profile of @ Requirements profile of @
Type Name Type Name Object ID

Editing Options
Generate Training Proposals

Qualification Deficits Only

* Key date: | 25.07.2022

Note: Search window will be displayed.
4. Click onthe T: Structure Search tab

= Poligh (1) %
S: Search Term | T: Structure Search | C: Abbreviation and Na... R: Se... > .., Profile Matchup

Search Term m

« Start Search  J» Multiple Selection  [¥] Close 3

Qualifications profile of @ Requirements profile of
Type Name Type Name
<> <> <>

e [0 A

Editing Options
Generate Training Proposals

Qualification Deficits Only

*Key date: 06.07.2022

Exit

Object ID

<>
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Note: Choose Person Page will be displayed.
5. Select a Person under STAFF ASSIGNMENTS ALONG ORGANIZATIONAL.

Choose Person X

Name D Code i ~ Exit
] ~ v Staff ass_r‘.ﬂrre\'ts along or@zamrat 5 - "
Profil > [ SETIA USAHA
> = ADMINISTRATION

Per
= Bahagian Pentadbiran Am

= BAHAGIAN PENTADBIRAN DAN KEWANGAN

= Bahagian Sumber Manusia &

= Cawangan dan Penga

>
>
>
>
> B Bahagian Sumber Manusia,PB
> an
> = Department

> ™ Government of Brunei

> ™ Government of Brunei

> ™ Government of Brunei Darussalam (test)
> . HT

> ™ Human Resource Management

> ™ Human Resource Management

- > = |nstitut Pendidikan Teknikal B

Editi > ® jabatan Pentadbiran dan Pekhidmatan2
> M jabatan penyelidikan brunei

> W Jabatan Penyelidikan Brunei

> = JBT Kementerian Pertahanan

> = Kementerian Hal Ehwal Luar Negeri ~

Note: A view page of Person will be displayed.
6. Select the Person by clicking on the checkbox beside the position.

7. Click on the Tick Icon.

= <

= Choose Person X

oy
X

Name D Code V... Exit
~ 19 Staff assignments along organizational s "
> [ SETIA USAHA
- [ ADMINISTRATION

(o]

> [ Bahagjan Pentadbiran Am
> ™ BAHAGIAN PENTADBIRAN DAN KEWANGAN
» [ Bahagian Sumber Manusia
> [ Bahagian Sumber Manusia,PB
> [ Cawangan dan Pengawasan
> [ Department
> [ Government of Brune £
> & Government of Brunei
> = Government of Brunei Darussalam (test)
> - HT
Editi > M Human Resource Management
> 8 Human Resource Management
> [ |nstitut Pendidikan Teknikal B
> [ Jabatan Pentadbiran dan Pekhidmatan2
> [ jabatan penyelidikan brunei

> [ Jabatan Penyelidikan Brunei

> HH JBT Kementerian Pertahanan
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8. Select the option Position from the dropdown.
9. Click on the Lookup icon to select Position(s).
< h!:‘ ’ Display Profile Matchup
v Morev Exit
Profile Matchup )
Person A% H
Qualifications profile of @ Requirements profile of &
Type Name Type Name Object ID
Person

Editing Options
Generate Training Proposals

Qualification Deficits Only

* Key date: 25.07.2022

Note: Search window will be displayed.
10. Click on the T: Structure Search tab.

= 10 1 (1) x > GHQ (1) 220 & _ 7 X
S: Search Term | T: Structure Search | C: Abbreviation and Na... R: Se... > .., Profile Matchup

Search Term: &8 * Exit

r Search  J+ Multiple Selection  [¥] Close %

Qualifications profile of 2] Requirements profile of @
Type Name Type Name Object ID
wme]| o me [ oo
: 3 Ha

Editing Options
Generate Training Proposals

Qualification Deficits Only

*Key date: 06.07.2022
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Note: Choose Position Page will be displayed.
11. Select a Position under GOVERNMENT OF BRUNEI.

= Profile Matchup Edit Goto System Help > GHQ (1) 220 & _ o X

< E' '7 Display Profile Matchup

= Choose Position >3
Exit

Profile  Name D Code Vali...

4
ignments along organizational s
3

ZOVERNMENT OF BRUNEI

5
v 1Y Staff assi
| p—

| PRIME MINISTER OFFICE

AINISTRY OF DEFENSE @

> VINISTRY OF FINANCE AND ECONOMY
> ™ MINISTRY OF FOREIGN AFFAIRS
) | MINISTRY OF HOME AFFAIRS

MINISTRY OF RELIGIOUS AFFAIRS

NISTRY OF PRI RESOURCES AND TOURISM
VIINISTRY OF HEALTH
NISTRY OF DEVELOPMENT

AINISTRY OF EDUCATION

> [ MINISTRY TRANSPORT INFOCOMMUNICATIONS
e > W MINISTRY OF CULTURE, YOUTH AND SPORTS
Editin —
> [ MINISTRY OF ENERGY
C > [ Unassigned Position

> [ HIS MAJESTY OFFICE (HMO)

Note: A view page of Positions will be displayed.

12. Select the Position by clicking on the checkbox beside the position.
13. Click on the Tick Icon.

= | = Choose Position x > GHQ(1)220 & 7 X
< ~
Name 1D Code V...
Exit
> & PEN.OPERESEN -
. > & PEN.OPERESEN
Profil¢ =
9 PENERBIT TKT 1
Use > & PENERBIT TKT 1
8 PENERBIT TKT 1

X

% PENGAWAS MCR

PENOLONG OPERESEN KANAN
PENOLONG OPERESEN KANAN
PENOLONG OPERESEN KANAN

o
=
=

PENOLONG O NAN

PENYELIA AL
4 + PENYELIA ARKIB ~
£ PENYIAR BERITA KANAN <y v

9 PENYUNTING ENG KANAN

£ | PENOLONG PENGURUS PERDAGANGAN
5 PENOLONG PERANCANGAN

Editin 9 PENOLONG PERANCANGAN

£ | PENYUNTING ENG

9 PENYUNTING ENG

]

PENYUNTING ENG
2 PENYUNTING ENG
% PERAKAM SUARA
£ JURUKAMERA ENG -
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14. Click on the Execute Icon to generate the Profile Matchup report.

$sApg 14

Display Profile Matchup

v | & | more v Exit
Profile Matchup
Person ~ Position v
Qualifications profile of & Requirements profile of &
Type Name Type Name Object ID
T !
v Person v Pasition KERANI
L a

Editing Options
Generate Training Proposals

Qualification Deficits Only

* Key date: 25.07.2022

Additional: Navigate to Editing Options and click on the Qualification Deficits Only

checkbox to generate a Profile Matchup report with deficits qualification only.

{ K : 'J Display Profile Matchup

~ L More Exit
Profile Matchup
Person v Position v
Qualifications profile of L] Requirements profile of &
Type Name Type Name Object ID
¥ Person v Position KERANI
o A < s
L © E ©
Editing Options
Generate Training Proposals
Qual\lica[aﬂ Deficits Only
* Key date: 25.07.2022
Refresh
119
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GENERATE CAREER Backend User

PLANNING REPORT JPA, SPA and Department HR Development

Log into SAP GUI (Back End) and proceed with the following steps.

1. Enter PPCP in the search bar.

11}
En
I
oy
X

Li: " SAP Easy Access

1
B/ F & & Othermenu W W A v A B Create role  More™ Q o @ B

> [ Favorites
~ T SAP Menu
> [7] Connector for Multi-Bank Connectivity
» [ Office
» [ Cross-Application Components
» [ Logistics
> [ Accounting
> [[] Human Resources
> [ Information Systems
> [ Service
> [T Tools
> [ WebClient Ul Framework

Note: Career Planning Page will be displayed.

< K : J Career Planning

= Morewv Exit

<L

Career Planning for

r .l
Person “ n
a
Planning Criteria Reporting period

38 Include qualifications * Key date: | 25.05.2022

G Include preferences

=3

Include potentials
Include designations

Respect Dislikes

e

Include career

Additional career:

Plan version ‘Current plan’ was set
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2. Navigate to Career Planning for, then select option Person from the dropdown.
3. Click on the Textbox and enter the assigned personnel number in the data sheet,
then press Enter on the keyboard.
4. Click on the Execute button.
< _ 8 %

Planning Edit Goto System Help

EE: ’ Career Planning
4 it More Exit

Career Planning for q q
lPerscn ~ I| 0

Planning Criteria Reporting period

® Include qualifications *Key date: | 04.07.2022

=

Include preferences

=14

Include potentials

Include designations

o &

Respect Dislikes

Include career

.
HI

Additional career

Plan version 'Current plan’ was set

5. Select the planning Criteria by clicking on the checkbox beside the criteria.

6. Click the Tick icon.

8]
X

= Career Plannir > GHQ (1) 220 & | _

< E : J Career Planning

(CHN Exit

Career Planning for

Person ~
Planning Criteria Reporting period
= Planning Criteria X g eiCN g SR 22
)

% Include qualifications

-

[i) Include preferences
B Include potentials
¥ Include designations
@ Respect Dislikes

& Include career

Additional career:

T
e
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Note: Career Planning Page will be displayed.

< r-!* ’ Career Planning

T .
I_| v = Profile o | P Morev

HeaderData

Personnel No. Name

EE group Pers.area

EE subgroup Cost Center

Career plan Key date: 03.06.2022 62,105 Targets found

Lll_'l = has qualifications for

Pegawai Latihan
1bn
1bn
2bn
2BN
2IC Auditor ABDB

2IC Pencen Baksis
3 WING SIGNAL - KERANI -
<>

7. Select one of the Qualifications.

8. Click on the Profile button.

= B _& x
< ’-E: J Career Planning
8
r .
i - H OB &  Morev Q d @
—Headerpata
Personnel No. Name
EE group Pers.area
EE subgroup Cost Center
career plan Key date: 03.06.2022 62,105 Targets found
= 3 has qualifications for
IPegawai Latihan I
lbn
lbn
2bn
28BN
2IC Auditor ABDB
2IC Pencen Baksis
-3 WING SIGNAL = KERANI .
I
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Outcome: Position: Display Profile Page will be displayed.

v

&' Succession Planning X Current Holder

Position: C\Pegﬁwai Latihan
Start: 01.01.1900 - 31.12.9999
Holder:
Org. unit: Pegawai Latihan
Requirements
Name

Qualification group

Nationality

Pengetahuan tentang kerasmian

Position: Display Profile (03.06.2022 - 03.06.2022)

. Proficiency

Yes
Yes

Start
01.01.2010
01.01.2010

Ess

-
1’uw,ﬂw;\
< & - B8 X
gi’ Exit
End Date Note
03.06.2022 .
03.06.2022

123
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GENERATE Backend User

SUCCESSION
PLANNING REPORT JPA, SPA and Department HR DeVEIOpment

Log into SAP GUI (Back End) and proceed with the following steps.

1. Enter PPSP in the search bar.

= < & _ g X

h!‘ " SAP Easy Access

1
PPSP| vl B = & 2 Othermenu W * 7 v A ® Createrole  More™ Q d @ e

> [ Favorites
~ T SAP Menu
> [7] Connector for Multi-Bank Connectivity
» [ Office
» [ Cross-Application Components
» [ Logistics
> [ Accounting
> [[] Human Resources
> [ Information Systems
> [ Service
> [T Tools
> [ WebClient Ul Framework

Note: Succession Planning Page will be displayed.

n
En
|

a]
X

< K : 'J Succession Planning

v ® B IZ Morev Exit

Succession Planning for

r .
Position ~ a
L 4
Planning Criteria Reporting Period
B8 Include qualifications * Key date: 26.05.2022

[il Include preferences
Include potentials
¥ Include designations
@ Respect Dislikes

& Include career

Additional career:

Plan version ‘Cument plan’ was set
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2. Navigate to Succession Planning for and select Position.

3. Click on the icon beside the textbox to choose the Position.

4. Click on the Clock Icon to execute.

= Planning Edit Goto System Help < cf‘ — -] x

{ K : J Succession Planning

Succession Planning for
-
Position ~
L

Planning Criteria Reporting Period

5

B Include qualifications “Key date: ©4.07.2022
il Include preferences

nclude potentials

N B

Include designations

Respect Dislikes

& Include career

Additional career:

The action was canceled

Note: Succession Overview for Organization Unit will be displayed.

= Planning Edit Goto System Help 2> GHQ (1) 220 o — 8 X
< w Succession Planning
e © [~ H More ~ Exit

Succession Planning for

Position L
Planning Criteria Reporting Period
= Planning Criteria ® “Key date: | 06.07.2622

M Include qualifications

Respect Dislikes

& Include career
[ =

Additional career:
[
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4. Select the Planning Criteria by clicking on the checkbox beside the criteria.
5. Click the Tick icon.
= Career Planning > GHG (1) 220 d — & X
< w Career Planning

Career Planning for

Person W

Planning Criteria Reporting period

Planning Criteria *® flexjcaleBerozlag22

ie qualifications

preferences

potentials

Respect
a Include career

Additional career:

Note: Ranking list of Candidate has been displayed.

I
B
|
e
X

< E : J Succession Planning

n 1 — 7 ]
v, = pofle ¥V OB B B  Morev Q o @FoExit

HeaderData

Position KETUA RANCANGAN

valid from 01.01.2021 - 31.12.9999
Holder

organizational Unit RADIO TELEVISYEN BRUNEI

Succession plan Key date: 03.06.2022 188 candidates found

Lm - is a qualification of

ABD. RAHMAN

ABDUL AZIZ

ABDUL AZIZ

ABDUL ZULAZMI ISMAHALI

Ahmad Faiz

AHMAD HUMAIZT

AMPUAN NURZATIDAH
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6. Select one of the Personnel.
7. Click on the Profile button.
= <6 &
< K : J Succession Planning
: : & M B ® Morew Q & Exit
—HeaderData
i e
Holder

organizational Unit RADIO TELEVISYEN BRUNEI

succession plan Key date

: 03.06.2022

£ M is a qualification of

I | ABD. RAHMAN
I ™ L ALLs T80 -

188 candidates found

I —ABDUL AZIZ

ABDUL ZULAZMI ISMAHALI

{———ahmad Faiz
———AHMAD HUMAIZI
AMPUAN NURZAIDAH

_|

Note: Person: Display Profile Page has been displayed.

seeg

&' Career Planning

Person: Display Profile (03.06.2022 - 03.06.2022)

-I- Current Position More Vv

Qualifications Potentials Preferences Dislikes Appraisals Where Appraisee
Qualification group Name Proficiency
Education HEALTH Bachelor Degree
Nationality Brunelan Yes

tentang P tentang Yes
UAT Testing Data Experience 01 Average
UAT Testing Data Experience 02 Very High
Umum D4 3 Tahun
Umum D5 6 Tahun

Appraisals Where Appraiser

Start

01.
01.
01.
01.
01.
16.
16.

01.
01.
01.
01.
01.
05s.
05.

Outcome: User is able to view employee’s qualification.

2005
2010
2010
2010
2015
2022
2022

End Date

31.
31.
31.
31.
31.
31.
31.

12.
12.
12.
12.
12.
12.
12.

9999
9999
9999
9999
9999
9999
9999

Individual development

Note

User Name
HCMSP1
HCMSPL
HCMSPL
HCMSPL
HCMSPL
HCMSPL
HCMSPL

De...

>

Changed on

16.
14.
14.
16.
16.
16.
16.

0s.
0s.
0s.
05s.
0s.
05.
0S.

2

NN N NN

oy
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GENERATESUCCESSION  Backend User
OVERVIEW FOR AN

ORGANISATIONAL UNIT JPA, SPA and Department HR Development

Log into SAP GUI (Back End) and proceed with the following steps.

1. Enter S_PH9 46000017 in the search bar.

= <& g0 x
»-.3! , SAP Easy Access
1
® F & QAotermeu K ¥ F vV A Hcreaterole Morev Q o P oex

» [ Favorites
~ 1 SAP Menu
» [1] Connector for Multi-Bank Connectivity
> [1) Office
» [ Cross-Application Components
> [ Logistics
» [ Accounting
> [[] Human Resources
» [*] Information Systems
> [ service
> [ Tools
> (1] WebClient Ul Framework

Note: Display Succession Overview will be displayed.

B 8 x
< >~ : J Succession Overview

~ (@ save as Variant. More Exit

Organizational Unit

=g

Organizational Unit o [=if

Search Term

Reporting Period
Key Date: |26.05.2022

Suitability Analysis:
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2. Click on the Lookup icon for Organizational Unit.
= < & _ O %
< - : J Succession Overview
~ @ save as Variant... Maore Exit

Organizational Unit 2

Q
D\'

=
Organizational Unit:
L

Search Term

Reporting Period
Key Date: 26.05.2022

Suitability Analysis:

3. Select Structure Search.

= Organizational unit (1) X > GHQ(1)220 & _ 8 X
S: Search Term | T: Structure Search |C: Abbreviation and Na... R: Se... ) ... Sion Overview

-
Search Term: &3 | Exit

Search % Multiple Selection  [¥] Close

Search Term

Reporting Period
Key Date: ©8.07.2022

Suitability Analysis
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4. Select the Organizational Unit under GOVERNMENT OF BRUNEI.

= program Edit Goto System Help >  GHO (1) 220 o =5 X

< E: J Succession Overview

Choose Organizational unit X
Exit

Orgar  Name 1] Code Vali...
\'r{ 3 Organizational structure 1
- = | | GOVERNMENT OF BRUNEI

PRIME MINISTER OFFICE

MINISTRY OF DEFENSE

MINISTRY OF FINANCE AND ECONOMY
MINISTRY OF FOREIGN AFFAIRS

MINISTRY OF HOME AFFAIRS

MINISTRY OF RELIGIOUS AFFAIRS

MINISTRY OF PRI RESOURCES AND TOURISM
MINISTRY OF HEALTH

MINISTRY OF DEVELOPMENT

MINISTRY OF EDUCATION

MINISTRY TRANSPORT INFOCOMMUNICATIONS
MINISTRY OF CULTURE, YOUTH AND SPORTS
MINISTRY OF EMERGY

Unassigned Position

HIS MAJESTY OFFICE (HMO)

7
Repol >
b

\

F§§E EE NN NENNOEGEN

\

o

LV

5. Select the Organizational Unit.

6. Click on the Select Subtree Icon.

7. Click on the Continue Icon.

l

> GHO(1) 220 & 5 X

Choose Organizational unit ®

Name [[>} Code V...
w 15 Organizational structure

~ 8 GOVERNMENT OF BRUNEI

~ #  PRIME MINISTER OFFICE

JABATAN PERDANA MENTERI
ADAT ISTIADAT
AUDIT
BIRO KAWALAN NARKOTIK
BIRO MEMCEGAH RASUAH
KESELAMATAN DALAM NEGERI
MAJLIS-MAJILIS MESYUARAT NEGARA

Orgar

LB BN BN BN BN BN A

Repoil

e

PERKHIDMATAN AWAM
PERKHIDMATAN PENGURUSAN

POLIS DIRAJA BRUNEI

SURUHANJAYA PERKHIDMATAN AWAM
JABATAN MUFTI KERAJAAN
BAHAGIAN UNDANG-UNDANG
PEMCETAK KERAJAAN

FPEJABAT PEGUAM NEGARA

JABATAMN KEHAKIMAN NEGARA

JET PENYELIDIKAN BRUNEI PERDAMA

LN B BN BN BN BN BN BN BN B |
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8. Navigate to Reporting Period and tick on the Suitability Analysis box.
9. Click on the Execute button.
= < & 7 x
< »!‘ J Succession Overview
Vv [E Save as Variant. More ™ Exit
Organizational Unit
Organizational Unit: : ED' o
Search Term:
Reporting Period
Key Dat 8 .05.2022
Suitability Ana ysws
9
Execute
Note: A view page for Planning Criteria will be displayed.
10. Check the Planning Criteria by clicking the checkbox beside the criteria then
11. Click the Tick icon.
= List Edit Goto System Help > GHQ (1) 220 d 9 X
SAP4 SAP
More A 4 Exi
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Outcome: Succession Overview for Organizational

generated.

Succession overview

Organizational unit O RADIO TELEVISYEN BRUNEI
O unit A
O Jabatan Radio Televisyen Brunei
O Bahagian BHES
O Bahagian Dasar Dan Perancangan
O Bahagian Pentadbiran Kejuruteraan
O Bahagian Peruntukan Dan Perancangan
O Bahagian Promosi
O Bahagian Rancangan Radio
O Bahagian Rancangan TV
O Kewangan

Succession overview

F:

i

More vV

Unit has been successfully

Organizational unit Object ID Object name

RADIO TELEVISYEN BRUNEI 30002148 J/TERA PNGWAS.
RADIO TELEVISYEN BRUNEI 30002149 PEN.OPERESEN KN.
RADIO TELEVISYEN BRUNEI 30002150 PENERBIT TKT.2
RADIO TELEVISYEN BRUNEI 30002151 PEMAIN MUZIK
RADIO TELEVISYEN BRUNEI 30002152 PEN.OPERESEN
RADIO TELEVISYEN BRUNEI 30002153 KERANI

RADIO TELEVISYEN BRUNEI 30002154 PEN.OPERESEN KN.

<>

Suitable qualification Has Potential Exp!

0

© © © © © ©

0

oonolollora

p

© © ©o © o © o

Slaliol OO o e

0

© © © © © ©

Careers Number of candidates found Suitability

0

© © o o o ©

Note: Navigate to the table column and double-click the desired column to view the list of

employees whose qualification matched with the position in the Organizational Unit.
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